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Fiery Color Profiler Suite

Fiery Color Profiler Suite lets you create a fully compliant color profile with International Color Consortium (ICC)
standards. It can also evaluate, edit, and test color profiles.

Fiery Color Profiler Suite usually comes with an EFI ES-2000 or Fiery ES-3000 Spectrophotometer; a measurement
instrument used to create profiles. Other measurement instruments are supported as well.

Fiery Color Profiler Suite offers several modules.

These modules help you create profiles and calibrate a Fiery server:

Fiery Express Profiler - Creates calibration sets and a profile for a Fiery-driven printer and creates Fiery job
properties preset and/or a virtual printer or a preset that lets you print with the new calibration and profile right
away. This module is the fastest way to profile a Fiery-driven printer.

Calibrator - Creates a new calibration set for a Fiery-driven printer or updates an existing one.

Fiery Printer Profiler - Creates profiles for any RGB or CMYK printer. Creates new calibration sets and profiles
for any Fiery-driven printer and allows access to expert profile settings.

Fiery Monitor Profiler - Creates profiles for CRT and LCD monitors.
Fiery Optimizer - Creates device link and media profiles and optimizes device link and media profiles.

Fiery Print Matcher - Creates calibration sets and profiles that match the color outputs of multiple Fiery-driven
printers (each Fiery server must run Fiery system software FS200/200 Pro or later).

These modules help you evaluate profiles:

Fiery Profile Inspector - Displays three-dimensional models of RGB, CMYK, and Named Color ICC profiles in
L*a*b color space, which lets you compare profiles.

Fiery Profile Editor - Allows you to edit output profiles. You can make global changes to an output profile or
select specific areas to edit.

Fiery Verify - Allows you to print and measure a color patch page and compare the measured results to the
expected results for a specific reference.

Fiery Color Profiler Suite also includes:

Fiery Verify Assistant is a utility for verifying a job’s color output. You can open Fiery Verify Assistant in
Command WorkStation when Fiery Color Profiler Suite and Command WorkStation are installed on the same
computer.

9
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What's new in this version

This version of Fiery Color Profiler Suite introduces new features.

What's new in version 5.9.1

e Support for the Epson SD-10 handheld spectrophotometer and Epson SD-10 Auto Chart Reader measurement
instrument.

o Support for optional Full Width Array (FWA) measurement instrument training in Calibrator.
e Moving your cursor over a target tolerance set result highlights the patch that caused the result in Fiery Verify.

¢ Addition of the 3D View icon in Fiery Verify opens a three-dimensional model of your sample or reference
measurement data in Fiery Profile Inspector.

o Support for optical density information in Fiery Profile Inspector when measuring a color in patch measurement
mode. Note that the optical density values are only meant to be checked for primary colors.

o Addition of the Fiery Color Profiler Suite eLearning option to the Help menu for improved access to Fiery Color
Profiler Suite eLearning courses.

e Support for macOS Tahoe 26.0.

e Various issues from Fiery Color Profiler Suite v5.9.0.27 are fixed.

Fiery Account

A Fiery Account is required for downloading software from Fiery Software Manager, including the upgrade to
Command WorkStation 7. An account is not required to install the software.

For more information, visit https://solutions.fiery.com/Account.

Software Requirements

This version of Fiery Color Profiler Suite requires a new license. If you are currently running version 5.x or 4.x and
your Software Maintenance and Support Agreement (SMSA) is current, then Fiery Color Profiler Suite downloads
the latest license automatically from the Fiery licensing server. To renew the Fiery Color Profiler Suite SMSA,
contact your Fiery reseller and provide the SMSA renewal part number 100000006105. Owners of Fiery Color
Profiler Suite 4.x may also purchase an upgrade from version 4.x to the latest version of 5.x including a year of SMSA
from their Fiery reseller through part number 3000013448 (digital delivery) or 3000013280 (physical delivery).

For the Fiery Color Profiler Suite launch points from Fiery Command WorkStation, Fiery Command WorkStation
6.7 and later is recommended (Fiery Command WorkStation 6.5 or later is supported). Launch points from previous
versions of Fiery Command WorkStation will not launch Fiery Color Profiler Suite 5.9.1 modules.
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System requirements
To run Fiery Color Profiler Suite, your Windows or Mac computer must meet the following minimum requirements.

Note: Fiery Color Profiler Suite v5.9.1 (CPS) is a native 64-bit application for both Mac and Windows platforms. The
32-bit operating systems are not supported for CPS v5.9.1. If Fiery Software Manager is already running on a 32-bit
operating system such as Windows 7 32-bit, it will not display the update notifications for the CPS v5.9.1 package. If
you attempt to install Fiery Software Manager on a 32-bit operating system, you will see a compatibility error, and
the installation will be canceled.

Windows e Windows 11
e Windows 10
e  Windows Server 2025
e  Windows Server 2022
macO$ e macOS 26 (Intel and Apple M-series native support)
e macOS 15 (Intel and Apple M-series native support)
e macOS 14 (Intel and Apple M-series native support)
e macOS 13 (Intel and Apple M-series native support)
Configuration

e 4GB of RAM (minimum) and 8 GB RAM or more is recommended
e 3 GB of hard disk drive space available for application use

e Minimum CPU:

® Intel® Core™ i5 Processor or higher

e AMD Ryzen™ 5 Processor or higher
e A monitor that supports 16-bit color with the following recommended resolutions:
® Minimum resolution:

e Windows: 1024x768

* macOS: 1024x800
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e Maximum resolution:

¢ Windows: 2560x1600

¢ macOS: 2560x1600

e The Fiery Verify module requires a monitor resolution of 1280x1024
e Sound card recommended
e 1USB 2.0 port (powered) for Fiery spectrophotometer. Additional ports needed for other measurement

instruments.

Note: The Fiery spectrophotometer does not work if connected to the USB port on most keyboards or to an
unpowered USB hub. The Fiery spectrophotometer and connecting cables are provided with Fiery Color
Profiler Suite.

Printer Any RGB, CMYK or CMYK+X color printer

Dongle and license requirements for Fiery Color Profiler Suite

Using the full functionality of Fiery Color Profiler Suite requires a spectrophotometer that has an activated license
connected to the computer that has the software. The spectrophotometer, such as the ES-3000, serves as a dongle or
a software license may be required.

For a list of supported spectrophotometers, go to https://www.fiery.com/spectro.

The following table describes additional information for specific measurement instruments.

Measurement Notes
instrument
Fiery ES-3000 The Fiery ES-3000 is included with Fiery Color Profiler Suite. The serial number is a 7-digit number on

the Fiery ES-3000 cradle and is also the serial number on the Fiery ES-3000 instrument.

Fiery ES-6000 Contact your Fiery representative for more information about the Fiery ES-6000.
TECHKON If you are using a Windows computer, you must also download and install the latest driver from the
SpectroDens Download Center in Application Software and Tools > TECHKON SpectroDens > All v2.0.0.8 (https://

product-redirect.fiery.com/TECHKONSpectroDensDriver).

Ricoh Color When using the Ricoh Auto Color Adjuster, do one of the following:

Adjuster
e Associate the Ricoh Auto Color Adjuster with a Fiery Color Profiler Suite software-only license,

and the measurement instrument serves as a dongle.

e Connect a licensed measurement instrument, such as the ES-3000, to a computer with the Fiery
Color Profiler Suite software installed, and then connect to the Ricoh Auto Color Adjuster to use it
as a measurement instrument only.

Note: The Fiery Color Profiler Suite license must be installed on a computer different from the one
where the Ricoh Auto Color Adjuster application is installed.
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An activated spectrophotometer license is valid for that spectrophotometer only; any other supported
spectrophotometer may be used for measuring into Fiery Color Profiler Suite provided that the licensed
spectrophotometer is also connected to the computer on which Fiery Color Profiler Suite is running. Some inline
measurement instruments are supported by the Fiery Color Profiler Suite certificate-based licensing.

If you connect a Fiery factory licensed spectrophotometer before starting Fiery Color Profiler Suite for the first time,
Fiery Color Profiler Suite automatically downloads and installs the license when the application starts.

Note: If Fiery Color Profiler Suite cannot connect to the Internet, see Download a Fiery Color Profiler Suite license
on page 15.

If you connect a spectrophotometer that is unlicensed, you must activate the license. (See Activate a Fiery Color
Profiler Suite license on page 15).

If a spectrophotometer is not connected, or you do not want to activate the license, you can run in Demo mode.

Demo mode

If a licensed spectrophotometer is not connected to the computer, Fiery Color Profiler Suite can run in Demo mode.

About Fiery Color Profiler Suite Demo mode:

¢ You can use all Fiery Color Profiler Suite options in Demo mode to create, edit, and modify CMYK calibrations
and profiles. You can also run color verifications with simulated measurements.

¢ You can use the demo or sample profile for production, but they may not produce the desired result.
o Single patch measurement is not supported in Demo mode.

o Fiery Monitor Profiler and Fiery Print Matcher modules of Fiery Color Profiler Suite are unavailable.

Troubleshoot "Dongle not found" message

If a licensed spectrophotometer is not connected when Fiery Color Profiler Suite starts, the "Dongle not found"
window appears.

Note: If a licensed spectrophotometer is connected but the "Dongle not found" message appears, you may need to
activate the Fiery Color Profiler Suite license.

+ Click one of the following:

¢ Download License - Downloads the license from the Fiery license activation website. You can download the
license from any computer that is connected to the Internet, even if Fiery Color Profiler Suite is not installed.

¢ Activate License - Activates a valid Fiery Color Profiler Suite license that is already on your desktop. This is
useful for a system that cannot download the Fiery Color Profiler Suite license from the Internet. In this case,
download the Fiery Color Profiler Suite license for your spectrophotometer serial number from
activation.fiery.com/cps. Save the downloaded license file on your desktop.

¢ Run in Demo Mode - Runs Fiery Color Profiler Suite in Demo mode.

¢ Server License - Allows the selection of a Fiery server with network Fiery Color Profiler Suite license support.

Note: The Server License may not be supported on all Fiery servers.
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Troubleshoot "Dongle not licensed" message

If a "Dongle not licensed" message appears and a spectrophotometer is connected, the license might not be available
and activated.

Problem

Action

An Internet connection was not available when
Fiery Color Profiler Suite first started, so a
license was not downloaded.

If Fiery Color Profiler Suite started without an Internet connection, connect
to the Internet, start Fiery Color Profiler Suite, and then click Download
License.

You downloaded the license, but it is not on
the computer’s desktop.

Move or copy the license to the computer’s desktop.

You have not activated the license.

If you already downloaded the license and the license file is on the desktop,
click Activate License.

You have activated the license but it is for a
different spectrophotometer than the one that
is connected.

Connect the spectrophotometer associated with the license.

The Fiery Color Profiler Suite version you are
running does not recognize the license
although you are sure it is the correct license
for your spectrophotometer.

Check that your license is valid for the version of Fiery Color Profiler Suite
that is installed.

1 Open a browser and go to activation.fiery.com/cps.

2 Enter the serial number or the License Activation Code, and then click
Submit.

3 The version number that is shown must match the version number that
appears when you select Help > About Fiery Color Profiler Suite in the
Fiery Color Profiler Suite main window.

Fiery Color Profiler Suite does not activate
with the connected spectrophotometer.

Check the spectrophotomer serial number in the lower-left of the "Dongle
not found" window. Enter this number at activation.fiery.com/cps to
download the license for the connected spectrophotomer.

If you want to use Fiery Color Profiler Suite without a license or spectrophotometer, click Run in Demo Mode.
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Download a Fiery Color Profiler Suite license

Your computer downloads a license from the Internet. If the computer does not have an Internet connection, you
can download the license from another computer and move it to the computer that has Fiery Color Profiler Suite
installed.

To download the Fiery Color Profiler Suite license, you must have the serial number of a valid dongle or a License
Activation Code. For a list of measurement instruments that can be used as a dongle, see Dongle and license
requirements for Fiery Color Profiler Suite on page 12.

The License Activation Code is on the license card in the Fiery Color Profiler Suite media pack.
1 Do one of the following:
¢ In the Fiery Color Profiler Suite main window, click Help > Download License.

¢ Open a browser and go to activation.fiery.com/cps.

2 After the Fiery License Fulfillment page opens, enter the spectrophotometer serial number or the License
Activation Code, and then click Submit. Do not enter both.

Note: If you use the EFI ES-2000 or Fiery ES-3000 serial number, enter only the 7-digit string shown on the
cradle. Omit the other numbers that are part of the serial number on the instrument.

3 Do one of the following:
¢ Save to File - Saves the license to the specified location.

Note: The license file must be on the desktop for activation to occur. After activation, Fiery Color Profiler Suite
copies the file to a location on your hard disk.

* View License File - Lets you view the license file, and then save it or send it in an email message.

¢ Send by email to - Sends the license to the email address you enter. (This is useful if you want to use Fiery
Color Profiler Suite on another computer.)

4 If you want to use Fiery Color Profiler Suite on a computer that does not have an Internet connection, copy the
license file to portable media and then copy the license file to the other computer’s desktop.

Activate a Fiery Color Profiler Suite license

The downloaded Fiery Color Profiler Suite license file must be on the computer’s desktop for activation. To activate
the license on that computer, you must connect the correct spectrophotometer. If a spectrophotometer is not
connected, the Demo mode message appears.

If your computer does not have Internet access, you must copy the license file to the desktop of the computer that
has Fiery Color Profiler Suite installed.

1 Connect the licensed spectrophotometer to the computer.
2 Do one of the following:
¢ In the Fiery Color Profiler Suite main window, click Help > Activate License.

¢ Click Activate License in the Dongle Not Licensed window.
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Update Fiery Color Profiler Suite

Updates to Fiery Color Profiler Suite are handled by Fiery Software Manager, which is installed when you install
Fiery Color Profiler Suite. It is recommended that you update the Fiery Color Profiler Suite regularly to obtain the
latest features, fixes, enhancements, and verification standards. You will have the best user experience when Fiery
Color Profiler Suite is at the latest version.

Note: To qualify for upgrades that add new features, Fiery Color Profiler Suite requires a current Software
Maintenance and Support Agreement (SMSA). Your SMSA renewal date is displayed in Fiery Software Manager. If
your SMSA is expired, contact your Fiery reseller to renew. You will need to provide the reseller with the serial
number of the spectrophotometer being used to license Fiery Color Profiler Suite.

If you receive a new Fiery server or a Fiery Color Profiler Suite kit with an older release of Fiery Color Profiler Suite,
you are entitled to upgrade to the latest release of Fiery Color Profiler Suite at no charge, and receive one year of the
SMSA coverage from the date the new Fiery server or Fiery Color Profiler Suite is installed.

In these cases, use the following steps to obtain the updated Fiery Color Profiler Suite SMSA.
e Send an email to profilersupport@fiery.com.

e In the email, provide the serial number of the EFI ES-2000 or Fiery ES-3000 that came in the Fiery Color Profiler
Suite kit or the License Activation Code (LAC) for a software-only version of Fiery Color Profiler Suite.

o Fiery will provide a 1-year SMSA extension from the date you received Fiery Color Profiler Suite.

e You can then download and use the latest version of Fiery Color Profiler Suite. The software will be downloaded
from https://fiery.com/cps/download. Please contact your Fiery Account Manager for additional information.

1 Click Help > Check for Updates.

2 In the Fiery Software Manager window, click Download and Install and follow the on-screen instructions to
install an update.

Set general preferences

The General tab lets you set preferences that apply to all modules of Fiery Color Profiler Suite.

Set dE calculation method preferences

There are many ways to calculate "Delta E", the numerical difference between two colors. This is often written as dE
or AE. You can use the Preferences tab to set how Fiery Color Profiler Suite calculates dE.

Tolerance values are in units of dE and the calculation method: for example, 0.5 dE 94.

You can set which method Fiery Color Profiler Suite uses to interpret all dE values that you specify in Fiery Color
Profiler Suite.

1 In Fiery Color Profiler Suite, click Edit > Preferences.
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2 Click one of these calculation methods in the dE Calculation Method list:

e dE 76 - The standard CIE method. The color difference is the distance between the two colors, calculated in
three-dimensional Lab color space.

e dE 94 - A variant of CIELAB that CIE TC1-29 recommends as the color difference formula. For graphic arts
applications, this method uses K1 = 0.045 and K2 = 0.015.

e dE 2000 - A variant of CIELAB that CIE recommended in 2000. This method uses KL = KC = KH = 1.0.

e dE CMC - The ratio of differences in lightness to chroma and to hue calculated using the ISO standard ISO 105-
J03. Values for lightness and chroma weights are 1.0 for use with perceptibility data.

Create Virtual Printers

In Fiery Color Profiler Suite, you can create a Virtual Printer when a new calibration set and profile are created. This
preference determines whether Fiery Color Profiler Suite will automatically create a Virtual Printer, ask if a Virtual
Printer should be created when a profile and calibration are created, or never create a Virtual Printer.

1 In Fiery Color Profiler Suite, click Edit > Preferences.

2 On the General tab, set Create Virtual Printers.

The choices are:

e Ask - prompts the user to chose whether to create a Virtual Printer when creating a new calibration set and
profile using Fiery Express Profiler or Fiery Printer Profiler modules.

e Always - automatically creates a Virtual Printer when creating a new calibration set and profile using Fiery
Express Profiler or Fiery Printer Profiler modules.

¢ Never - does not automatically create a Virtual Printer when creating a new calibration set and profile using
Fiery Express Profiler or Fiery Printer Profiler modules.

Create an additional calibration set and profile for CMYK

You can automatically create a CMYK calibration set and profile when a CMYK+ calibration set and profile is being
created.

1 In Fiery Color Profiler Suite, click Edit > Preferences.

2 On the General tab, the Create an additional CMYK calibration set and profile from CMYK+ measurement data
is selected by default.
When saving a calibration set for a CMYK+ profile, a CMYK profile is also saved. The CMYK profile is saved with
_CMYK added to your file name.
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Calibrate the spectrophotometer

For reliable measurements, you must calibrate the spectrophotometer before measuring. You cannot continue with
the measurement if you cannot calibrate the spectrophotometer successfully.

Note: This procedure applies to the EFI ES-2000 or the Fiery ES-3000 spectrophotometer.

1 Place the spectrophotometer in its cradle, and then press the button on the spectrophotometer or click Calibrate
on the screen.

2 If calibration fails, make sure the white tile on the cradle is uncovered and the white tile and instrument aperture
are clean, and then repeat the calibration.

If calibration succeeds, you can continue with your measurements.
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Fiery Express Profiler

With Fiery Express Profiler, you can quickly create a calibration setting and an output profile for a printer connected
to a Fiery server. Fiery Express Profiler also creates a virtual printer or server preset configured with the new output
profile so that you can immediately print a job using the new output profile.

Note: If the Fiery server is running Fiery system software FS200/200 Pro or later, Fiery Express Profiler creates a
server preset and optionally a virtual printer.

Create calibration and profile in Fiery Express Profiler
To create a calibration and an output profile, you specify the Fiery server and then print and measure a calibration
page and a profiling measurement page.

Settings for printing the calibration and profiling measurement pages are set in Preferences. Check these settings the
first time that you use Fiery Express Profiler and change them if necessary.

1 In Fiery Color Profiler Suite, start Express Profiler.

2 In the Welcome window, click Select Fiery server and select the Fiery server from the list.

If the Fiery server is not in the list, click the plus sign to add it using the IP address or by searching.

Note: If the printer has an inline instrument installed, the Use printer in-line instrument option is selected. If
you prefer to use another instrument, clear the check box.

You can select the Use recommended patch layout for optimal results check box to use a recommended patch
layout.

3 Type a name for the profiling session and click Next.

This name will be used for the calibration, the output profile, and the optional virtual printer or server preset that
you will create.

4 Select a CMYK source profile from the list and click Next.
CMYK source profile will be used to create server preset and to print profile test page.
5 Select any job settings needed to print the warm-up pages and the calibration page and click OK.

The same job settings will be used to print the subsequent profiling, calibration, and test pages. The profiling
patches are now printed with the new calibration.

6 Click OK, retrieve the pages from the printer, and follow the on-screen instructions to measure the calibration
page.

A new calibration setting is created.
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Click OK, retrieve the profiling measurement page or pages from the printer, and follow the on-screen
instructions to measure the page or pages.

After you finish measuring the page, the profile is created and installed on the Fiery server.

Click Test Print to print a test page using the new profile.

Make sure to select the server preset that was created recently to print the test page. The server preset will have
the preset name as set in step 3.

Click Done.

A virtual printer or server preset with the same name as the output profile is created. To print a job using the new
output profile and calibration setting, print to this virtual printer or apply the server preset to the job.

Set Fiery Express Profiler preferences

The Express Profiling tab lets you set how the calibration and profiling measurement pages are printed in Fiery
Express Profiler. When you configure these settings before profiling, you do not need to select them each time you
create a profile.

1

In Fiery Color Profiler Suite, click Edit > Preferences.

Alternately, you can click the Preferences button in the lower left corner of the Express Profiler window.
Go to the Express Profiling tab.

Select your preferred spectrophotometer in the Instrument list.

Make sure the selected spectophometer is plugged into the system running Fiery Color Profiler Suite.

If you want to make specific settings for the measurement instrument, click Settings.

Select a patch layout in the Profiling patch layout list.

For the best quality and results, select the recommended Fiery Edge patch layout chart. You can also choose from
alternative chart layouts if a custom patch layout chart is needed.

ICC standard targets are the basis for some of the common patch layouts:
¢ Recommended

e A recommended Fiery Edge patch layout chart is listed. When listing the recommended patch layout chart,
Fiery Color Profiler Suite considers your measurement instrument, sheet size, and calibration set. The
number of patches and expected pages will be displayed.

¢ Fiery Edge alternatives

¢ Dynamically generated patch layout charts are listed in order of the number of patches. You can choose
from four patch layouts.

¢ Industry Standard

* IT8.7/5 (1617 patches) - The 1617 target is a CMYK printer characterization target combining the unique
patch values in the standard 1T8.7/4 target with all the patch values in columns 4 and 5 of the P2P51 target.

e |T8.7/4 (1617 patches) or IT8.7/4 (1617 sorted layout) Are similar to the 928-patch layouts but provide
more data. The sorted layout helps to reduce potential bias caused by color variation across the page.
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Select a patch layout in the Calibration patch layout list.
Generally, more patches are better but it will take longer to measure.

A greater number of patches yields more measurement data, which may produce better results. However, more
patches take longer to measure.

Select a paper size in the Chart size list, or click Custom to set a custom page size.

To print warm-up pages before printing the calibration page, select and specify Number of warmup pages.
A warmed-up printer usually prints more consistently. If the printer has been idle, print 5-10 warm-up pages.
Select Maximum GCR if you want the new profile to be saved with the Maximum GCR setting.

Maximum GCR automatically sets the separation (black control) settings to maximize the GCR (gray component
replacement) of the profile. It can help to improve the gray balance of prints, achieve better compliance with
industry color standards, and maximize the output gamut.

Note: Maximum GCR is not available when using a Fiery Edge target.
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Fiery Printer Profiler

Fiery Printer Profiler can create custom output profiles for most RGB and CMYK printers: Fiery-driven, Fiery XF
server-driven, inkjet, non-Fiery, and printing presses. Use Fiery Printer Profiler with a measurement instrument
(such as the spectrophotometer included with Fiery Color Profiler Suite) to create an output profile for the print
system using specific substrate and image quality settings.

The profiles created are fully compliant with International Color Consortium (ICC) standards, so that you can use
them with industry standard applications and platforms. You can create a new calibration setting as part of the
profile creation process. It is always recommended to create a new calibration set as well as a printer profile for each
paper type. With Fiery Printer Profiler, you can also import existing measurements, from files or ICC profiles, and
modify the gamut mapping and black controls before saving a new profile.

To generate a profile, you print pages of color patches (to show the color behavior of a printer), measure the patches,
and then create a profile using the measured values. You can start Fiery Printer Profiler at any point in this process.

o Express Profile - see Fiery Express Profiler on page 19.

e Print Patches - Start here if you want to create a new profile and optionally, a new calibration setting, and have
not printed a patch page.

e Measure Profiling Patches - Start here if you have patch pages that were printed earlier or on a printer at
another location after measurements, a profile can be created using this workflow.

o Convert Measurements to Profile - Start here if you want to import measurements from an I'T8 file that contains
spectral or colorimetric data or from an existing ICC profile. At this point a profile can be created from the
measurements or if an ICC profile is loaded a variation on it can be created by changing the settings in the Fiery
Printer Profiler Apply Settings window.

Profile a Fiery-driven print system
You can create a profile for a printer connected to a Fiery server. The Fiery server must be accessible from your
computer over the network.

1 In Fiery Color Profiler Suite, click Printer to start Fiery Printer Profiler and then click Print Patches - | want to
start from the beginning.

2 Inthe Welcome window, type the new profile name and select the Fiery server from the list, and then click Next.
If the Fiery server is not in the list, click the plus sign to add it using the IP address or by searching.

For most fiery-driven systems, choose CMYK for the Color Space.
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In the Calibration setup window, click the appropriate option and click Next.

¢ Create new calibration setting - Create a new calibration set for the media to be profiled. This option is the
optimal choice. Select this option if you wish to include G7 calibration as part of the calibration process. If G7
calibration is desired, select G7 calibration options and choose the G7 gray balance calibration option.

Note: The G7+ calibration workflow is only available from Calibrator. For more information, see Fiery
Calibrator Help.

¢ Use existing calibration setting - Use existing calibration settings with recalibration. Prints calibration patches
for measurement to recalibrate based on the selected calibration setting before profiling. An existing
calibration setting will only result in a high quality profile if it was created for the same or a very similar media
to the one that is being profiled.

e Select Skip re-calibration only if this calibration setting is up-to-date. (The Fiery server was calibrated recently
for this calibration setting.) In this case, complete step 4 and then go to step 10.

If Skip calibration is selected, the selected calibration setting is used to print profiling pages immediately

without calibration. Only skip the calibration if the calibration setting has just been created.

Note: If the Fiery server does not support calibration, skip this step and go to step 10.

Select a CMYK source profile from the list and click Next.

The CMYK source profile will be used to create the server preset and to print the profile test page.

Select the instrument, patch layout, and paper chart size for printing the calibration page. We also recommend
warming up the printer by printing at least 10 warmup pages.

More calibration patches are generally better but take longer to measure.
To change the instrument settings, click Settings next to the instrument.

Click Print. Go to step 6 to set the print settings.

Specify print settings and click OK.

Specify settings including image options, such as halftone and resolution, and media settings. Best practice is to
choose the media using a substrate catalog, paper catalog, or media catalog entry.

Note: Depending on what is supported on the Fiery server, either Substrate Catalog, Paper Catalog, or Media
Catalog is displayed in the user interface.

Retrieve the pages from the printer and follow the on-screen instructions to measure the calibration page.
(Discard any warmup pages.)

View the measurement results and click Next on the Patch Layout window.

Select the instrument, patch set, and chart size for printing the profiling measurement pages.

Click Settings to configure settings for the measurement instrument. Always use at least 928 patch for a high
quality profile.

If you want to measure multiple sets of pages and then average the measurements into one set of data for creating
the profile, specify the number of page sets to print.

10 Click Print.

11 Retrieve the measurement pages from the printer, follow the on-screen instructions to measure them.

Note: If the printer measures the pages automatically, you can skip this step.
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12 In the Summary window, check the results.

Check to see that the dE values (average and maximum) are not colored red. If they are, the measurement values
were not precise and you may wish to re-measure.

Click Average measurements to view all measurement sets and proceed to measuring the next set, if any.

13 In the Apply Settings window, select the factory profile from the Fiery server for a paper like the one you are
profiling (coated, uncoated). This will load the profile settings that were used to create the manufacturer-
approved factory profile.

Note: Sometimes the factory profiles from the Fiery server do not appear in the Profile Settings menu. In this
case, use the import command from the Settings menu to connect to the Fiery server to choose the factory
profile.

Note: The available settings depend on the capabilities of the printer.
14 In the Save Profile window, choose Install on Fiery Server. Make sure the correct Fiery server is selected.

The profile is created when you click Next and installed on the Fiery server.

A server preset is now available, which can be selected to print with the new calibration, output profile, source
profile, and all print settings used to create the output profile.

Profile a Fiery XF server

You can create a profile for a printer connected to a Fiery XF server. The Fiery XF server must be accessible from
your computer over the network.

For more information about the Fiery XF server, see the documentation that accompanies the Fiery XF.

1 In Fiery Color Profiler Suite, click Printer to start Fiery Printer Profiler and click Print Patches - | want to start
from the beginning.

2 In the Welcome window, click Select Fiery Server and select the Fiery XF server from the list. Under Printer
description, select the printer to profile.

If the server is not in the list, click the plus sign to add the server using the IP address or by searching.
3 Select ink, media name, and calibration set appropriate for the printer and the paper that you are using.
4 Select the instrument, patch set, and chart size for printing the profiling measurement pages.

¢ If desired, click Settings to configure the settings for the measurement instrument.

o If desired, click Expert Settings to configure patch pages to print as images or vector graphics.

If you want to measure multiple sets of pages and then average the measurements into one set of data for creating
the profile, specify the number of page sets to print.

5 Retrieve the measurement pages from the printer and follow the on-screen instructions to measure the
measurement pages.

6 In the Summary window, check the results.

7 Inthe Apply Settings window, select the profile settings or import settings from an existing profile.
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In the Save Profile window, choose Install on XF Server. Make sure the correct Fiery XF server is selected.

The profile is created and installed on the Fiery XF server.

Profile a remote, non-Fiery, or non-CMYK printer (Save as PDF)

You can profile a printer that is not connected to a Fiery server or Fiery XF server or that has a color space other
than CMYK by using the Save as PDF option.

Instead of printing the patch pages in Fiery Printer Profiler, you save them to a PDF file, and then you print the PDF
file manually before you can measure the patch pages in Fiery Printer Profiler.

1

6
7
8
9

In Fiery Color Profiler Suite, click Printer to start Fiery Printer Profiler and click Print Patches - | want to start
from the beginning.

In the Welcome window, click Save as PDF and select the color space of the printer.

Select the instrument, patch layout, and paper size for creating the measurement pages.

If desired, click Expert Settings to set the patch object type for CMYK or RGB (image or vector graphics).
Save the measurement page ID.

Save the PDF file.

The file is saved in Documents\Fiery Color Profiler Suite\Measurements (Windows) or Library/Caches/Fiery Color
Profiler Suite/Measurements (macOS).

Print the PDF file on your printer and retrieve the measurement pages.
Return to Fiery Printer Profiler and follow the on-screen instructions to measure the measurement pages.
In the Summary window, check the results.

In the Apply Settings window, select the profile settings or import settings from an existing profile.

10 In the Save Profile window, specify the desired settings.

11 Select Save on local drive.

The profile is created when you click Next.
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Select a printer for printing patch pages

To create a profile, you print patch pages to measure. To profile a non-Fiery printer or a printer that is not connected
to your computer, you can save the pages as a PDF and print them outside of Printer Profiler.

If you select a Fiery server, Printer Profiler retrieves the manufacturer, model, and color space from the Fiery
server. Printer Profiler also retrieves other settings used in creating the profile.

The Color Space setting is the printer’s preferred color space for creating an output profile. If you are creating a

profile to simulate the output of another printer, you may want to set the color space of the printer that you are

simulating. If your printer supports more than one color space, select the color space for the profile. The printer
must be already configured for the color space that you select.

If you set a Fiery XF server, you must also specify a printer that is set up in Fiery XF. (A Fiery XF server can have
multiple printers connected to it.) Printer Profiler also retrieves other settings used in creating the profile from
the Fiery XF server.

If the printer is not the linearization device, the printer settings automatically transfer to the linearization device.
The linearization device is the printer that is always used for profiling in Fiery XF.

If your printer is not in the list, make sure that the EFI Media Profiles folder contains an appropriate base
linearization file (*.EPL). You can create a new base linearization file for your printer in Fiery XF Color Tools, if
necessary.

If you save the file as PDF, you set CMYK or RGB as the printer color space.

Select a Fiery server or Fiery XF server

You can set a printer that has a connection to a Fiery server or Fiery XF server.

1
2

In Fiery Color Profiler Suite, start Fiery Printer Profiler and click Print Patches.

In the Welcome window, click Select Fiery Server and then select a server in the list.

If you click Select Fiery Server, the list contains recently selected servers connected through Command
WorkStation (if Command WorkStation is installed on your computer).

If the Fiery server or Fiery XF server does not appear in the list, click the plus sign (+) and select a server from the
network.

In the Printer description area, confirm the settings that appear or select new setting from the list.

Save patch pages as a PDF

Saving patch pages as a PDF lets you print them later or print them from a printer that is not on your network.

1
2
3

In Color Profiler Suite, start Printer Profiler and click Print Patches.
In the Welcome window, click Save as PDF.

In the Color Space list, click the color space of the printer you are profiling.
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Set up calibration

Printer Profiler lets you set the type of calibration for the printer that you are profiling. Some printers use the
printer’s current calibration state and require no calibration setup.

Set up calibration for a Fiery server

Fiery calibration uses a calibration that specifies the target density values (the calibration target) for a Fiery server.

For best results, when you create a new profile, create a new calibration setting to be used with the new profile. It
will include a calibration target based on the current state of the printer.

If you do not create a new calibration setting, you can use an existing calibration with the new profile, but only if the
paper that you are profiling is very similar to paper of the existing calibration. For example, if the new paper is a
coated, heavy paper, the existing calibration must be for a coated, heavy paper. If the paper is not very similar, the
calibration target is not appropriate for the paper.

« In the Calibration Setup window, click one of the following:

¢ Create new calibration setting - Prints and measures a set of patches without calibration applied and
calculates an appropriate calibration target. In this case, the new profile is associated with the new calibration
setting.

The G7 calibration options check box is not selected by default. If you wish to conduct G7 calibration, select
the check box and choose G7 gray balance calibration.

Note: The G7+ calibration workflow is only available from Calibrator. For more information, see Fiery
Calibrator Help.

¢ Use existing calibration setting - Uses the selected calibration setting to print and measure patches, unless
you select Skip calibration. In this case, the new profile is associated with the selected calibration setting.

Skip calibration only if the calibration is up-to-date.

e CMYK source profile - Selects CMYK source profile that will be used when creating server preset and printing
profile test page.

Set up calibration for a Fiery XF server

When you profile a printer connected to a Fiery XF server, you specify the ink type, media name, and the calibration
set (base linearization).

1 Connect to the Fiery XF server, and choose the printer and printer model.
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2 In the Calibration Setup window, set the following:

¢ Ink type - If the printer supports more than one type of ink, set the ink type for profiling.

¢ Media name - Sets the combination of media type and calibration set. A calibration set specifies a base
linearization file that is associated with a media profile.

¢ Calibration set - Set print conditions that adjust the printer behavior to the media.

Print conditions include resolution, halftone settings, color mode, print direction, and media profile. You must
specify a calibration set because a media name can be associated with more than one calibration set.

Print pages for calibration

The Calibration print settings window lets you specify calibration pages.

Color patches are printed on the calibration page according to the measurement instrument, layout, and paper size
that you specify. You can also set the number of warmup pages to print. (Warmup pages are extra pages that you can
discard.)

A greater number of patches yields more measurement data, which may produce better results. However, more
patches take longer to measure.

1 Select the Instrument, Patch layout, and Paper size to use for printing the calibration page.
2 (Optional) To make specific settings for the instrument, click Settings.

3 Click Set number of warmup pages and then set a number.

Warm up pages are useful in the event that the press is not run before the calibration and profile. If the press was
running jobs right up until the time of profiling, then it should be sufficiently warmed up without printing any
warm up pages.

If you selected G7 or G7+ calibration in the Calibration Setup window, the initial Fiery calibration is performed as
normal, before the G7 or G7+ calibration process is initiated. (See the G7 calibration workflow on page 29 or G7+
calibration workflow on page 29.)

Review calibration measurement results

After taking calibration measurements, you can review the resulting maximum density (D-Max) values of the
calibration target.

1 Review the calibration results, and click Next.

2 Ifany results are questionable, click Reprint next to the results to reprint and remeasure a calibration page.
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G7 calibration workflow

G7 calibration is conducted between the Fiery server calibration and printing of profiling measurement patches.

G7 calibration is applied on the top of the Fiery server calibration. Entering the G7 calibration process, you will
select the patch layout for the P2P target you wish to use, measure them, inspect the results, and make adjustments
to the settings, if needed.

The G7 specification defines standard grayscale curves that can be used to create a common neutral appearance of
output on different printers. G7 calibration adjusts the color output of a printer to the G7 specification, using
measurement data from a specific G7 target (P2P target). Fiery Color Profiler Suite supports printing and measuring
different P2P targets that are used for G7 calibration. You can measure with any supported measurement
instrument, including inline measurement instruments, in which case the process can become automated without
user interaction.

1 In the Patch layout window, select the G7 patch set you want to use:
e P2P51 (the newer target, a revision of the original)
e P2P25Xa (the original target)

Note: The actual values used in the targets are similar, but the newer version is a more precise version of the G7
specification.

2 Click Print and measure the patch page.

3 Review the G7 gray balance measurement results.

Because this is the G7 calibration run, it is expected that the results are failing. It is the measurements from this
target that will be used to calculate the NPDC curves necessary for G7 calibration.

The NPDC (Neutral Print Density Curve) is displayed separately for CMY (composite) and K (black). Gray
balance is plotted as a*b*. In the table, the weighted average must be less than 1.5 to show as green. The weighted
maximum must be less than 3 to show as green.

4 (Optional) Click Correction options to display the correction curve, and expose advanced options applied to the
formation of the correction curves.

You can choose to keep the defaults or change them.
5 Click OK to print the P2P patch page again with the NPDC curves applied.
6 Measure the patch pages and view the G7 results.

7 If the G7 result is passing (all results show in green), click Next. If the result is failing (any result highlighted in
red), then click Iterate to repeat the process. Additional iterations will not lead to better results. You can perform
a maximum of four iterations.

Proceed to Print patch pages for profiling on page 30.

G7+ calibration workflow

G7+ calibration is conducted between the Fiery server calibration and printing of profiling measurement patches.

G7+ calibration is applied on the top of the Fiery server calibration. Entering the G7+ calibration process, you will
select the patch layout for the P2P75+ target, measure it, inspect the results, and make adjustments to the settings, if
needed.
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The G7+ specification defines standard grayscale curves that can be used to create a common neutral appearance of
output on different printers. G7+ calibration adjusts the color output of a printer to the G7+ specification, using
measurement data from a P2P75+ target. Fiery Color Profiler Suite supports printing and measuring a P2P75+ target
that is used for G7+ calibration. You can measure with any supported measurement instrument, including inline
measurement instruments, in which case the process can become automated without user interaction.

1 In the Patch layout window, select P2P75+ from the G7+ patch set list.
2 Click Print and measure the patch page.

3 Review the G7+ gray balance measurement results.

Because this is the G7+ calibration run, it is expected that the results are failing. It is the measurements from this
target that will be used to calculate the NPDC curves necessary for G7+ calibration.

The NPDC (Neutral Print Density Curve) is displayed separately for CMY (composite) and K (black). Gray
balance is plotted as a*b*. In the table, the weighted average must be less than 1.5 to show as green. The weighted
maximum must be less than 3 to show as green.

4 (Optional) Click Correction options to display the correction curve, and expose advanced options applied to the
formation of the correction curves.

You can choose to keep the defaults or change them.
5 Click OK to print the P2P75+ patch page again with the NPDC curves applied.
6 Measure the patch pages and view the G7+ results.

7 Ifthe G7+ result is passing (all results show in green), click Next. If the result is failing (any result highlighted in
red), then click Iterate to repeat the process. Additional iterations will not lead to better results. You can perform
a maximum of four iterations.

Proceed to Print patch pages for profiling on page 30.

Print patch pages for profiling
To create a profile in Fiery Printer Profiler, you must specify print options and other settings for sending the patch
pages to the printer.

If you plan to print multiple sets of patch pages and average the measurements, you can specify the number of sets.
(You can use the average of the measurements to create the profile.)

Note: Before you print the pages, you can specify other print settings, such as media and halftone. Do not change
any color management settings.

1 In the Print Settings window, select the measurement instrument in the Instrument list.
2 (Optional) If you want to make specific settings for the measurement instrument, click Settings.

3 (Optional) If you want to make specific settings for the patch layout page when using large patches, click Patch
settings.

The patch layout can be changed for a Fiery XF server version 7.0 or later when using the inline calender
attachment. Use of the inline calender can cause outgassing that affects the original color patch pages used for
calibration. Color patch pages with increased spacing between the rows are substituted for the original color
patch pages.
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You can change the patch layout settings when connected to the following measurements intruments only:

e EFIES-2000
e Fiery ES-3000
e Fiery ES-6000 (Ethernet)
e X-RiteilPro 2
e X-Rite i1Pro3
e X-RiteilPro 3 Plus
¢ X-Rite iliO3
e X-RiteiliO3+
¢ Barbieri Spectro LFP
e Barbieri Spectro LFP gb
¢ Konica Minolta MYIRO-1
¢ Konica Minolta MYIRO-9
¢ Ricoh Auto Color Adjuster
4 Choose a patch layout in the Patch Layout list.
ICC standard targets are the basis for some of the common patch layouts:
¢ Recommended

e A recommended Fiery Edge patch layout chart is listed. When listing the recommended patch layout chart,
Fiery Color Profiler Suite considers your measurement instrument, sheet size, and calibration set. The
number of patches and expected pages will be displayed.

¢ Fiery Edge alternatives

e Dynamically generated patch layout charts are listed in order of the number of patches. You can choose
from four patch layouts.

¢ Industry Standard

* IT8.7/5 (1617 patches) - The 1617 target is a CMYK printer characterization target combining the unique
patch values in the standard 1T8.7/4 target with all the patch values in columns 4 and 5 of the P2P51 target.

e IT8.7/4 (1617 patches) or IT8.7/4 (1617 sorted layout) - Are similar to the 928-patch layouts but provide
more data. The sorted layout helps to reduce potential bias caused by color variation across the page.

Note: To use a patch layout that is not available in Printer Profiler, you can print and measure patch pages with
Verifier and then import the measurements in Printer Profiler.

5 Select a media size in the Paper size or Chart size list, or click Custom to set a custom size.

In Fiery XF, the media size is set up for the printer in System Manager.
6 To print multiple sets of patch pages and measure them, specify Number of sets.

7 Click Next and save the ID for the measurement pages.
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Set patch options

If desired, click Expert Settings to configure patch pages to print as images or vector graphics.

Choose an .it8 file to select a patch page to measure
Each set of patches is defined by an .it8 file. When a profiling session is started from the Fiery Printer Profiler Print
Patches workflow, a name is given for the profiling session. This name will be used for the .it8 file.

If you already have patch pages to measure when you start Printer Profiler, you can proceed directly to measuring the
patch pages. In this case, you must select the .it8 name from a list that contains recently created .it8 files.
Information for the selected .it8 file appears in the Patch settings field. You can check that an .it8 file is correct by
checking the date and time that appear with the patch settings.

Select the .it8 file for your patch pages

To measure a set of patch pages, you first select an .it8 file.

1 In Color Profiler Suite, start Printer Profiler and click Measure Profiling Patches.
2 Click Select an it8 file.

3 Select the unmeasured it8 and click Open.

Summary of measurements

After measurement data is available, the Summary window displays a summary of information about the
measurements and the conditions used to create them. The dE (sometimes referred to as AE or Delta E) values
summarize the variation in measurements of the same color.

If a dE value is displayed in red, it is because the variation appears to be significant. The variation does not
necessarily indicate an error, but consider these values for realistic expectations. Your profile cannot be any more
accurate than what has been measured.

You may want to examine the printed profiler patches for physical blemishes or consider remeasuring the patch
pages.

You can also check for potential problems with the measurement data by viewing the color space that the
measurements represent in Profile Inspector.
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Choose data for averaging measurements

If you have sets of measurements from multiple sets of patch pages, Fiery Printer Profiler calculates an average of the
measurements to create the profile. You can add or remove measurement sets to include or exclude the data in the
average.

1 In the Summary window, click Average measurements.
2 Do one of the following:

¢ To add a file to the list, click Import measurement, browse to select an IT8 measurement file, and then click
Open.

e To remove an IT8 file, deselect the check box next to the file in the list.

Determining or switching the profiling engine used for the profile creation
Two profiling engines are supported. You can determine the profiling engine used for the profile creation or switch
the profiling engine based on the profile that was imported.

The available profiles are listed in the Settings list under two categories, Fiery Edge Factory Default Profiles or
Factory Default Profiles.

The profile that you select in the Settings list in the Apply settings window determines the color profiling workflow
that will be used. The user interface displays the options available for the profile you select.

If you import an ICC profile that you created previously with Fiery Color Profiler Suite through Import Settings in
the Settings list, then Fiery Color Profiler Suite will switch to the profiling engine that is associated to that profile
and the user interface will update accordingly.

You can evaluate the type of profiling engine by clicking the Settings list once more and the profile will either be
listed under Fiery Edge Factory Default Profiles (which will use the Fiery Edge profiling engine) or under Factory
Default Profiles (which will use the previous non-Fiery Edge profiling engine).

For the selected profile, information about the associated options can be found at:

e Apply profile settings (for non-Fiery Edge profiles) on page 33
o Edit profile settings for Fiery Edge profiles on page 37

Apply profile settings (for non-Fiery Edge profiles)

After you make or import measurements in Printer Profiler, the Apply settings window lets you set the profile’s
gamut mapping, separation settings, profile optimization, and viewing condition. It is highly recommended that you
load existing settings from a factory default profile from your Fiery server and the type of paper (coated, uncoated)
that you are profiling.

Note: The available settings vary, depending on the capabilities of the printer.

The profile that you select in the Settings list in the Apply settings window determines the color profiling workflow
that will be used. The user interface displays the options available for the profile you select.
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For more information about CMYK factory default color profile settings, see:
¢ Set maximum GCR on page 34

o Set profile optimization on page 34

o Setviewing condition on page 35

¢ Set gamut mapping on page 35

o Specify separation settings manually on page 36

For more information about Fiery Edge color profiling technology, see Edit profile settings for Fiery Edge profiles on
page 37.

Load settings

Apply the settings from an existing profile.

1 In the Apply settings window;, click a profile in the Settings list.

Choose the factory default profile for the type of paper you are profiling (plain, coated, heavy coated, etc). The
default profile gives the settings used to create the press-manufacturer-approved factory profile for that kind of

paper.

Note: The settings that are displayed in the Apply settings window are determined by the profile you select in the
Settings list. For more information about possible workflows, see Apply profile settings (for non-Fiery Edge
profiles) on page 33.

2 Ifaprofile does not appear, click Import Settings in the Settings list to connect to the Fiery server, then select
the profile.

Set maximum GCR

The Maximum GCR option automatically sets the separation (black control) settings to maximize the GCR (gray
component replacement) of the profile.

Maximum GCR can help to improve the gray balance of prints, achieve better compliance with industry color
standards, and maximize the output gamut.

« In the Apply settings window, click Maximum GCR.

Set profile optimization

The Optimize colorimetric precision option uses optimization to improve colorimetric precision and reduce dE
(sometimes referred to as AE or Delta E) values.

« In the Apply settings window, click Optimize colorimetric precision (Recommended for proofing workflows).
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Set viewing condition

You can set the color of ambient light in which prints are intended to be viewed. It is recommended to leave this
option set to D50 and always evaluate color quality visually in a D50 light booth.

« In the Apply settings window, do one of the following:

¢ Click a setting in the Lighting value list.

¢ Click the plus sign (+) to create your own setting, either by using a measurement instrument or by specifying
the XYZ value.

Set gamut mapping

An output profile contains information for different types of gamut compression with different rendering intents.
Rendering intent settings control how gamut mapping occurs.

The Edit Gamut Mapping window displays the colormetric mapping, saturation blending, and perceptual mapping
used for gamut mapping. These settings apply to both RGB and CMYK profiles.

The default settings for the gamut mapping options are recommended for most profiles.

e Colorimetric mapping applies to the Absolute Colorimetric and Relative Colorimetric rendering intents. It
determines how an output color is matched to a source color.

e Saturation blending applies to the Presentation rendering intent.

o Perceptual mapping applies to the Photographic rendering intent.

1 In the Apply settings window, click Edit Gamut Mapping.
2 Click one of the following in the Colorimetric Mapping list:

¢ Closest dE (closest numerical match) - Sets the output color value that is closest to the source color value
numerically in units of dE 76. This setting generally produces the most visually appealing color.

¢ Closest dE Enhanced Shadows (for restricted gamuts) - Sets the output color value that is closest to the
source color value numerically, except that it adjusts color values in shadow regions to provide smoother
gradations. This setting may enhance results when profiling on media with a small gamut.

¢ Constant hue (sometimes more visually pleasing) - Sets the output color value closest to the source color
value in the same hue. This setting might produce more desirable output than Closest dE (closest numerical
match). For example, a blend from pure white to pure blue is smoother with this setting. Photographic images
with a wide range of sky blue tones also reproduce better.

¢ Closest dE 2000 (closest numerical match) - Sets the output color value that is closest to the source color
value numerically in units of dE 2000. This setting generally produces the most visually appealing color.
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3 Click one of the following in the Saturation Blending list:

¢ Enhance Gamut Blending (smoother transitions) - Generates smooth transitions through the entire gamut,
making larger adjustments for colors farther from the neutral axis.

¢ Use Presentation Method from EFI Profiler 1.5 - Preserves continuity if you have used EFI Color Profiler v1.5
to create profiles and want to match the profile you are creating now with your existing profiles.

¢ CIECAM saturation - Produces more natural colors when using the Presentation rendering intent, based on the
latest CIE color appearance model.

4 Click one of the following in the Perceptual Mapping list:

» EFI photographic (Match Fiery workflows) - Matches Fiery workflows.
¢ Perceptual (ICC standard) - Standard ICC mapping.

¢ CIECAM presentation - Produces more natural colors when using the Photographic rendering intent, based on
the latest CIE color appearance model.

Specify separation settings manually

Separation settings control how to handle black in the output. You can edit black controls for CMYK profiles. If you
are making an RGB profile, separation settings do not appear.

Note: Change the separation settings only if the settings loaded from a factory profile as described in Load settings
on page 34 or the preset you chose do not provide satisfactory results. If you choose to manually edit the black
settings, it is best to start with the settings loaded from the factory profile.

1 In the Apply settings window, click Edit Black Controls.
2 Set the following values in the Edit Black Controls window:

¢ Maximum Total Ink - Sets the total amount of ink allowed for the four channels: Cyan, Magenta, Yellow, and
Black. The maximum value is 400%, which is 100% for each channel. Different types of output devices have
standard maximum total ink values. The setting imported from the factory default profile is a value appropriate
for the specific print system being profiled.

e Maximum Black Ink - Sets the total amount of ink that is allowed for black. You might reduce this value from
100% if that value produces undesirable effects, such as an unwanted difference between black and other
colors. It is almost always desirable to leave this value at 100%.

¢ Black Start - Sets the minimum percentage of ink at which black is introduced into the mix of inks making up a
specific shade of color. You might set the start point at 10-25% to reduce graininess in highlights when the
black screen is grainy by increasing the black start point.

¢ Black Generation - Controls the tone curve shape of the black separation. Increase this value to get more black
used instead of other colorants and to increase contrast. Reduce this value if the black separation is too high in
contrast.

Set the Black Start option before setting the Black Generation option. Black Generation controls black output
from the Black Start to the Maximum Black Ink value. For maximum black generation, set Black Generation to
99%. Do not set Black Generation to 100% if maximum black ink is also set to 100%.
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¢ Increase black in shadows - On some printers, adding cyan, magenta, and/or yellow to black ink can cause the
black value to become lighter, rather than darker and richer. Adjusting this setting can make shadows appear
more pleasing on those printers.

¢ Maximum CMYK density ratio - Affects rendering of the dark point of an ICC profile.

If this option is not selected, the dark point is determined automatically. Automatic selection works well in
most general applications.

This option lets you specify the amount of black in the dark point. A ratio of 0% means that the dark point of
the profile contains K only. A ratio of 30% means that the dark point contains 70% K plus additional percentage
(to Maximum Total Ink) of CMY. This option works well in situations where 100% K is darker than 400%
CMYK.

¢ Black Width - Controls the distance from the neutral axis at which black generation is applied. A higher value
uses more black off-axis in saturated colors; a lower value does not extend black generation as far out from the
neutral axis.

¢ Black Amount to Extend Gamut - For most printers, the default value of 100% is sufficient. If there is a grainy
appearance to the black halftone in saturated colors, reduce the percentage.

Edit profile settings for Fiery Edge profiles
The profile settings control how to handle black settings, gamut mapping, and processing options in the output for
Fiery Edge default profiles.

After you select a Fiery Edge default profile, the Apply Settings window lets you edit profile settings for the selected
profile.

Note: Change the settings only if the default settings do not provide satisfactory results. If you are profiling a Fiery
server, the default settings are the optimal settings for this type of Fiery server.

1 Inthe Apply settings window, click Edit Profile Settings.
2 Click the tabs to specify values for the following:

¢ Black settings - The Black settings are used to set the black colorant usage at the black point and black
generation throughout the profile.

e Gamut mapping - Perceptual and saturation options for Fiery Edge controls that adjust the visual appearance
of prints made using the perceptual and saturation rendering intents.

¢ Advanced settings - Processing options for Fiery Edge profiles to adjust input data and table smoothing,
illuminant, and table sizes.

Black settings for Fiery Edge profiles

You can change the default values of the black settings to set the black colorant usage at the black point and black
generation throughout the profile for your printer.

1 Click the Black settings tab.
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2 Turn on Ink saving to reduce the amount of ink in the profile.
Choose one of the Apply ink saving controls: Low, Medium, or High.
The ink saving setting will visually affect the relevant black generation parameters and set them to values that are

inline with the ink saving strategy. If you change any of the black settings manually after selecting an ink saving
setting, the current ink saving setting may change from low, medium, or high.

Note: The Ink saving feature is available if your printer supports it.

3 Select the Black-only gray balance check box to use minimal CMY ink or toner.

When the Black-only gray balance check box is selected, you can only adjust the Black width value. If the Ink
saving feature is turned on and you select the Black-only gray balance check box, the Black width value will be
unavailable.

4 Set the following values for Black generation:

¢ Black ink start - Controls when black ink is introduced on the white-to-black neutral axis (the L* axis) of the
profile. You might adjust this value to adjust the stability of the gray balance or to reduce graininess in
highlights when the black screen is grainy.

¢ Black generation - Controls the rate at which black ink is added along the white-to-black neutral axis. A high
value adds black at a high rate. A low value adds black at a slower rate.

¢ Black width - Controls the rate at which the black ink on the neutral axis is added to increasingly chromatic
(more saturated) colors. Low values of black width hold the neutral-axis black amounts close to the neutral axis
of the profile, while high values of black width allow the neutral-axis black amounts to extend outward into the
gamut.

¢ Gray balance preview (0-100%) - Shows the relationship between the input value and the actual output
colorant value as a percentage.

5 Set the following values for Black point:

The Black point controls are specified in Relative Colorimetric values.

¢ Black point finder - When selected, the profile will automatically identify a black point. When the setting is
not selected, specify the CMYK ink amounts to use for black.

¢ Maximum black ink - Sets the upper limit for black ink used for the black point of the profile. You might
reduce this value from 100% if that value produces undesirable effects, such as an unwanted difference between
black and other colors. The default setting is a value appropriate for the type of printer being profiled. We
recommend you start with the default.

¢ Search radius (AE ab): If Black point finder has been enabled, this control allows you to search the radius
around the target a*b* for black point.

¢ Target (a*) - This is the target a* of the black point.
¢ Target (b*) - This is the target b* of the black point.
¢ Black point preview - Shows the L*a*b* values for CMYK.

¢ Rich black L*a*b* - The Rich black values are set according to the values defined in the Black point controls.
Both Relative Colorimetric and Absolute Colorimetric values are shown for comparison purposes.

¢ Pure black L*a*b* - Pure black represents the colorimetry of black ink only. Both Relative Colorimetric and
Absolute Colorimetric values are shown for comparison purposes.
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6 Set the following values for Black blending:

¢ Yellow to composite black transition - Sets the delay of black added to yellow.
Low - Use for smaller black drop size printer.
Medium - Use for medium black drop size printer.
High - Use for large black drop size printer.

¢ Transition point - Sets the rate at which black ink is added to yellow. The adjustment ranges are from 0 (most
delayed use of black) to 1 (start darkening with black directly). Typically setting the control to 1 will produce
the maximum color gamut in a region but will introduce black ink at higher lightness colors. In some instances,
the addition of black ink gives a grainy appearance in skin tones. For these cases move the adjustment to lower
values to delay the use of black.

¢ Black blending preview - Shows the color shift from solid yellow to composite black. Solid yellow is 100% Y.

7 Click Apply to save your selections, click Reset to reset to the default settings, or one of the other tabs.

Gamut mapping for Fiery Edge controls

These controls adjust the visual appearance of prints made using the perceptual and saturation rendering intent.

1 Click the Gamut mapping tab.

If you are using a factory profile with hue rotation, you can customize the Fiery Edge gamut mapping settings by
clicking Revert to Legacy Mode.

2 Set the following values for Perceptual gamut mapping:

¢ Chroma - Choose from three levels of chroma boost for the perceptual rendering intent. The Normal mode
indicates that adjustments are not made to the chroma of the reproduction. The Colorful mode provides a
modest boost of the in-gamut color. Select this mode to create slightly more chromatic output. The Vivid mode
provides a more aggressive chroma boost to in-gamut colors. Select this mode when highly saturated colors are
the goal.

¢ Brightness - Adjust the global lightness of the printed colors. Larger negative values produce darker colors and
higher positive values produce lighter colors.

¢ Contrast - Adjust the global contrast of the printed colors. Larger negative values reduce the contrast and
higher positive values increase the contrast of the reproduced colors. At the midpoint (0), the original contrast
is preserved.

¢ Brightness in shadow area - Increase the lightness in dark colored regions selectively while maintaining the
lightness in brighter tones. There are four levels of Brightness in shadow area adjustment: Normal, Lighten
shadows (low), Lighten shadows (medium), and Lighten shadows (high). These settings progressively
increase the brightness in the darker tone regions. Use these adjustments to enhance the detail in the darker
tones.
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3 Set the following values for Saturation gamut mapping (Fiery Intensify):

¢ Chroma - Choose from four levels of chroma boost for the saturation rendering intent. The Normal mode
indicates that adjustments are not made to the chroma of the reproduction. The Low mode provides a
minimum boost of the in-gamut color. The Medium mode provides a modest boost of the in-gamut colors.
Select this mode to create slightly more chromatic output. The High mode provides a more aggressive (large)
chroma boost to in-gamut colors. Select this mode when highly saturated colors are the goal.

¢ Brightness - Adjust the global lightness of the printed colors. Larger negative values produce darker colors and
higher positive values produce lighter colors.

¢ Contrast - Adjust the global contrast of the printed colors. Larger negative values reduce the contrast and
higher positive values increase the contrast of the reproduced colors. At the midpoint (0), the original contrast
is preserved.

¢ Brightness in shadow area - Increase the lightness in dark colored regions selectively while maintaining the
lightness in brighter tones. There are four levels of Brightness in shadow area adjustment: Normal, Lighten
shadows (low), Lighten shadows (medium), and Lighten shadows (high). These settings progressively
increase the brightness in the darker tone regions. Use these adjustments to enhance the detail in the darker
tones.

» Reference for Fiery Intensify rendering - Defines how the colors in your image are processed based on the
reference RGB profile. Select either SRGB(PC) or Adobe RGB (1998). This control defines the way the colors in
your image are processed, and produces vivid and highly colored prints. It makes best use of the gamut of your
printer.

4 Click Apply to save your selections, click Reset to reset to the default settings, or one of the other tabs.

Processing options for Fiery Edge profiles

Processing options for Fiery Edge profiles to adjust input data and table smoothing, illuminant, and table sizes.

1 Click the Advanced settings tab.
2 Set the following values for the following:

¢ Measurement data smoothness - Controls the amount of smoothing that is performed on the measurement
data used to create the profile. Increase the Smoothness value to smooth out noisy color gamut
measurements, such as those from inkjet production printers running at a low resolution. Decrease this
control for less noisy printers.

¢ |CC profile smoothness - Controls the amount of smoothing to the output tables. There are separate controls
for Perceptual, Colorimetric, and Saturation. Increase the smoothing for rendering smoother gradients and
decrease the smoothing for more accurate color renditions.

¢ Lookup table size - Determines the number of table entries in the Perceptual, Colorimetric, and Saturation
input and output tables. Larger tables produce more accurate color but take longer to calculate and the ICC
profiles take up more hard disk space. For critical print-reproduction tasks, increase the output table sizes. For
critical proofing tasks, increase the input table sizes.

¢ llluminant- Provides a list of standard illuminations. Choose the illuminant that matches the light viewing
conditions for your printed output.

¢ [CCversion- Allows you to save the output profile for ICC version 2 or ICC version 4.
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Click Apply to save your selections, click Reset to reset to the default settings, or one of the other tabs.

Save a profile in Fiery Printer Profiler

The Save Profile window lets you save a profile and include a description and other information. You can save the
profile locally or install it on a Fiery server or Fiery XF server.

Note: In Demo mode, you can save a profile in an unlocked format. You can use the demo or sample profile for
production when printing from a Fiery server or Fiery XF server, but they may not produce the desired result.

1
2

In the Print Settings window, type the profile’s description.

Optionally, type any comments that you want to store with the profile.

Type the name of the media associated with the profile.

For example, type the manufacturer and brand name of the paper used to print the patch pages.
Do one of the following:

¢ To install the profile on a Fiery server, click Install on Fiery Server and click the Fiery server in the list.

If the Fiery server that you want does not appear in the list, click the plus sign (+) and select it from the
network.

¢ To install the profile on the Fiery XF server that you selected when you started, click Install on XF Server.

¢ To save the profile locally, click Save on local drive.

Click Next.

If you save the profile locally, navigate to the new location of the profile, type a file name, click the ICC profile
type (v2.0 or v4.0), and then click Save.

Import measurements for creating a profile

If you already have measurements in either an IT8 file or a Color Profiler Suite-created ICC profile, you can use

those measurements to create a profile. This is a simple way to update an existing profile’s settings without changing

its measurement data.

You can import measurements from one or more I'T8 files or from a single profile. If you import measurements from
more than one file, Printer Profiler uses the average of the imported measurement sets to create the profile. You may

want to use the average of multiple measurements if printer output is inconsistent or to create a common profile for
multiple printers.

If the import measurements are in the wrong format, a warning appears. The measurement file or files do not
contain enough information to create a valid profile. The files must meet these requirements:

Measurement files must conform to the CGATS.17 format.

All of the files together must contain a sufficient number of measurements.
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Import measurements from one or more IT8 files

You can import measurements from one or more IT8 files.

1 In Color Profiler Suite, start Printer Profiler and click Convert Measurements to Profile.
2 Click Measurement File, and then click Next.

3 Select one or more files, and then click Open.

Import measurements from an ICC profile

If you import measurements from an ICC profile, you can import from only one ICC profile at a time. You cannot
average the measurements from two ICC profiles.

1 In Color Profiler Suite, start Printer Profiler and click Convert Measurements to Profile.
2 Click ICC Profile, and then click Next.

3 Click the file, and then click Select.

S

If the Missing Information window appears, do one of the following:

¢ If you know the manufacturer or model, specify the manufacturer and model for the printer associated with
the profile.

¢ If you do not know the manufacturer or model, specify the generic settings.

Create profiles based on the new profile

You can use the new profile to create a profile that has the same measurement data but with different settings, or
create a device link profile that uses the new profile as its destination.

+ Do one of the following:

¢ To create a profile that has the same measurement data but different settings, click Change Settings, which
returns you to the Apply Settings window.

¢ To create a device link profile that uses the new profile as a destination, click Device Link.

Verify a created profile

After creating a new profile, you can optionally verify your printer profile with the Fiery Verify Assistant.

1 Click Verify in the window.
The Fiery Verify Assistant window opens.

42
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Select one of the following options:

¢ Mathematical verification - A verification preset is calculated against the color reference without printing and
measuring.

¢ Practical verification - A verification preset is provided and includes printing and measuring color test
patches.

Specify the Verification preset and click Next.
Click Next.

Click Done to close the Fiery Verify Assistant.

Optimize a created profile

You can optimize your printer profile with the Fiery Optimizer module.

1
2

After creating your printer profile, click Optimize.

(Optional) Click Verify to verify your optimized profile. For more information, see Verify a created profile on
page 42.

Click Print to print the color test chart.

Click Exit.

Set Printer Profiler preferences

The Printer Profiler tab lets you set tolerance for calibration and measurement checks. These settings are specific to
Printer Profiler.

Set calibration check tolerance

Fiery Printer Profiler can check whether the maximum densities for the primary printer colors on the profiling patch
target match expected values (based on the current calibration). You set how much mismatch to allow without
generating a warning.

1
2
3

In Fiery Color Profiler Suite, click Edit > Preferences.
In the Printer Profiler tab, select the Calibration check tolerance check box.

Enter the tolerance in the % density field.
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Set measurement check tolerance

Printer Profiler can be set to alert you when duplicate color patches within a single profile target are significantly
different from each other. This is an indication that you may have made bad measurements or your printer may have
too much color variance within the page area to profile successfully. You can set how much mismatch to allow
without generating a warning in units of AE.

1 In Color Profiler Suite, click Edit > Preferences.
2 In the Printer Profiler tab, click the Measurement check tolerance check box.

3 Enter tolerance values in the Average dE and Maximum dE fields.
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Calibrator

Fiery-driven presses and printers come in different flavors: laser or inkjet; monochrome or CMYK or extended
gamut, with or without specialty inks. Calibrator is designed to address the different calibration needs of each
technology.

Command WorkStation and Fiery Color Profiler Suite will automatically launch the Calibrator version best suited to
your system. Calibrator will self-configure to adapt to the connected Fiery server. Not every press requires every
feature.

With Calibrator, you can create a new calibration setting on a Fiery server or update an existing one.

Like Calibrator in Command WorkStation, Calibrator can create a new calibration setting and recalibrate an existing
one, but with support for a variety of measurement instruments not available in Command WorkStation.

The two main functions of Calibrator are:

e Recalibrate - updates a calibration with fresh measurements. The output of many presses will vary over time. For
the Fiery server to compensate for such fluctuations, its correction tables need to be updated with fresh
measurements.

¢ Create calibration - creates a new calibration, and if Fiery Color Profiler Suite is installed and licensed, a new
profile. This task is needed when none of the existing calibration delivers acceptable output for a specific printing
condition (combination of ink set, halftone, substrate, etc.). Examples are poor gradations or bad ink adherence.
A new calibration will most frequently require a new profile, for color management to deliver accurate color.

Two administrative functions are accessible from two icons at the bottom left of the window. These settings are
specific to and saved in each individual Fiery server. Because they affect every user, these functions are available only
when logged as a Fiery administrator from Command WorkStation:

o Calibrator Settings - is used to set preferences for individual presses. This is where you can set pre- and post-
calibration settings available with some press models. All models also offer to warn or even prevent jobs from
printing when their applicable calibrations have not been recalibrated within a time frame the administrator
specified.

o Calibration Manager - is used to view calibrations available in a Fiery server, see when they were last updated,
their measurements and properties. User-added calibrations can be deleted, and their names modified.

Recalibrate a Fiery server

To recalibrate a Fiery server, you select the Fiery server, specify whether to create a new calibration or update an
existing one, and then print and measure a calibration page.
1 Click Reprint to reprint the patch page.

Reprint is not available when you have loaded measurements from a file.

2 Click Apply & Close to apply the calibration and close the calibration application.
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Fiery Monitor Profiler

Fiery Monitor Profiler lets you create a profile of a CRT or LCD monitor, including laptop computer screens.
Monitor Profiler uses the spectrophotometer included with Fiery Color Profiler Suite to measure a monitor’s color
output.

You can use the easy or advanced profiling method.

Note: Monitor Profiler is not available in Demo mode.

Prepare to use Monitor Profiler

It is important to prepare your monitor before using Monitor Profiler.

1 Set the display settings of your computer to the optimal resolution and best color quality.

2 Turn off any screensaver or other software that might interfere with the display, especially any graphic arts
software that might be color managing the display.

3 If your monitor has a control to reset the monitor to factory default settings, use it to reset the monitor.

Profile with the Easy method
The Easy method assumes the native monitor settings, and profiles the monitor in its current state.
You might use the Easy method if:

e You want to profile your monitor quickly.
e You want to profile your monitor in its current state or do not have a preferred state.

¢ Your monitor does not have controls for adjusting brightness, contrast, and RGB color.
1 Start Monitor Profiler and click Easy.

Calibrate and set up the spectrophotometer.

Measure profiling patches.

Compare before and after measurements.

i A W N

Save the profile.



Fiery Color Profiler Suite Help 47
Fiery Monitor Profiler

Profile with the Advanced method

The Advanced profiling method lets you specify desired monitor settings and calibrate the monitor to those settings,
and then profiles the monitor in its calibrated state. Advanced users can also calibrate a monitor to a specified target.

You might use the Advanced method if you want to:

e Profile your monitor calibrated to specific settings

o Use the monitor to emulate or match another monitor
e Be able to soft proof color on your monitor.

1 Start Monitor Profiler and click Advanced.

2 Select target settings for luminance, gamma, and white point.

If you select the Native setting for luminance, gamma, or whitepoint, Monitor Profiler will skip the calibration of
that parameter.

Calibrate and set up the spectrophotometer.
Measure and set luminance.

Measure and set gamma.

Measure and set the white point.

Measure profiling patches.

Compare before and after measurements.
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Save the profile.

Calibrate and set up the spectrophotometer

Before measuring monitor output, you must calibrate and set up the spectrophotometer.

Instrument calibration compensates for gradual drifts in the spectrophotometer. The spectrophotometer must be in
its cradle, and the sample aperture must be in full contact with the white tile on the cradle. (If its position in the
cradle is incorrect, the spectrophotometer returns inaccurate measurements.)

Note: The serial number on the spectrophotometer and the serial number on the cradle must match for accurate
spectrophotometer calibration.

1 When instructed by Monitor Profiler, place the spectrophotometer in its cradle, and then click Next or press the
button on the spectrophotometer.

2 If calibration fails, make sure the white tile on the cradle is uncovered and the white tile and instrument aperture
are clean. Use a lens cloth and, if available, a lens cleaning solution.

3 Place the spectrophotometer on the monitor, using the holder that is included with the spectrophotometer.

The spectrophotometer should lie flat in front of the outline displayed on the screen.The graphic in Monitor
Profiler shows the correct position for the spectrophotometer.
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Measure and set luminance

You can use Monitor Profiler to measure and set the brightness for the desired luminance.

Luminance describes a monitor’s brightness in candelas per square meter (cd/m2). Common luminance values range
from 50 to 300. Some recommended luminance values are:

e CRT-100

e LCD-120

e Aged CRT - 80 to 90
e Laptop-90

When you calibrate luminance, change only the brightness and no other monitor settings. The brightness control
might be a physical button or an on-screen display (OSD) that appears on the monitor.

1 Correctly position the spectrophotometer for measuring.

2 Ifyou use an OSD, position the OSD away from the spectrophotometer (in a corner of the screen, for example).
3 When Monitor Profiler tells you, adjust the brightness to the maximum value and click Next.
4

Reduce the monitor’s brightness until the measured luminance matches the target luminance.

After each time that you adjust the brightness, wait a few seconds to allow the spectrophotometer to measure
and display the resulting luminance.

5 Click Next.

Measure and set gamma

You can use Monitor Profiler to measure and set the contrast for the desired gamma.

Gamma refers to the encoding of the luminance value to compensate for the nonlinearity in human vision, in order
to achieve the best image quality for a given bandwidth. Gamma is the relationship of the encoded luminance to the
desired output luminance. The gamma value affects the white point, the global ability to display RGB neutrals, and
the global darkness and contrast that the monitor can display.

Typical gamma values range from 1.8 to 2.2 depending on the device.

When you calibrate the gamma, change only the contrast and no other monitor settings. The contrast control may be
a physical button on the monitor or an on-screen display (OSD) that appears on the monitor.

1 Position the spectrophotometer correctly for measuring.

2 Ifyou use an OSD, position the OSD away from the spectrophotometer (in a corner of the screen, for example).
3 When Monitor Profiler tells you, adjust the contrast to the maximum value and click Next.
4

Reduce the monitor’s contrast until the measured gamma matches the target gamma.

After each time that you adjust the contrast, wait a few seconds to allow the spectrophotometer to measure and
display the resulting gamma.

5 Click Next.



Fiery Color Profiler Suite Help 49
Fiery Monitor Profiler

Measure and set the white point

You can use Monitor Profiler to measure and set the white point (RGB) settings that result in the desired white
point.

The white point defines the exact white that the monitor displays.

Warm White (5000K) - Also known as D50, is a yellowish white, recommended for image reproduction on CRT
monitors. 5000 K is also the recommended viewing light for soft-proofing.

Medium White (6500K) - Also known as D65, is a daylight white, recommended for image reproduction on CRT
or LCD monitors if you prefer a white that is cooler than Warm White.

Cool White (7500K) - Is a bluish white, for situations that specifically require a bluish white.

When you calibrate the white point, adjust only the white point and no other monitor settings. The white-point
controls might be physical buttons on the monitor or an on-screen display (OSD) that appears on the monitor. After
you calibrate the white point, you might need to adjust the brightness.

1
2

Correctly position the spectrophotometer for measuring.
If you use an OSD, position the OSD away from the spectrophotometer (in a corner of the screen, for example).

Locate the white point controls on your monitor.

The control labels might be for white point, RGB, or color settings. There might be a single white point control or
there might be three controls for Red, Green, and Blue.

Click Next.

If your monitor has a single white point control:

a) Adjust the control until the measured white point value matches the target value as closely as possible. After
each adjustment, wait a few seconds for the spectrophotometer to measure and display the results.

b) Skip to step 9 on page 50.

If you the monitor has three controls for Red, Green, and Blue:
a) Find the control with the middle value.
b) Set the other two controls to that value as well.

c) If these settings result in a noticeable color cast, reduce the dominant color (for example, reduce Red if the cast
is reddish) to remove the cast.

d) If the color cast persists, set Red, Green, and Blue to 20.
Do one of the following:

¢ If the measured white point value is higher than the target value, either increase Red or reduce Green and Blue
together (keeping the same value for Green and Blue), until the measured white point value matches the target
value as closely as possible.

o If the measured white point value is lower than the target value, either reduce Red or increase Green and Blue
together (keeping the same value for Green and Blue), until the measured white point value matches the target
value as closely as possible.
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8 Adjust Green and Blue to match the target white point as closely as possible.

You might not be able to match the target value exactly.

9 If the measured luminance no longer matches the target value, adjust the brightness control until it does.
(Changing the white point can change the luminance.)

10 If the measured luminance is still too low at the maximum brightness setting, and your monitor has controls for
Red, Green, and Blue, gradually increase all three controls, maintaining the same ratios, until the measured
luminance matches the target value.

11 Click Next.

Measure profiling patches

Monitor Profiler displays a sequence of full-screen color patches that are measured by the spectrophotometer. You
use the measurements to create a profile.

1 DPosition the spectrophotometer correctly for measuring.

2 Wait while Monitor Profiler displays a sequence of color patches.

This may take several minutes.

3 When Monitor Profiler reappears with a message that the measurements were completed, click Next.

Compare before and after measurements

Before you save the profile, you can check the measurements captured by Monitor Profiler by observing how a new
monitor profile affects the display of a sample image. You can display the sample image using the new or existing
monitor profile.

1 In the measurement results window, click Compare before and after to display the sample image.
2 Do one of the following:
¢ Click After to display the sample image using the new monitor profile.

¢ Click Before to display the sample image using the existing monitor profile.

Save a profile in Monitor Profiler

You can provide a description for the profile. and save it to your local system. The new profile automatically becomes
the default monitor profile.

1 In the measurement results window, type a description that helps identify the profile.
2 Click Next.

3 Browse to the location for the new profile, type a file name, and click Save.
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Monitor Profiler saves the profile in ICC v2.0 format.
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Fiery Optimizer

Fiery Optimizer can help you use a device link profile or an optimized media profile to match color output to an
industry reference. Fiery Optimizer also lets you create device link profiles using two to four profiles.

Fiery Optimizer offers these options:

e Media profile optimization (Iterative match to a standard) - Matches the output of your Fiery-driven printer to
an industry reference. Fiery Optimizer creates a media profile using a CMYK source profile and an output profile
on the Fiery server as the destination profile. Using measurements of color sample patches, converted with the
media profile being created, Fiery Optimizer can optimize the media profile to better match the color
appearance of the industry press reference. With repeated iterations of media profile tuning, and measuring
results from printed color patches, you can optimize the appearance match. The optimized media profile can
also be used when you select another source profile. Fiery Optimizer installs the profile on the Fiery server.

¢ Media profile gray optimization - Improves a media profile to produce neutral grays in the best possible way.
The gray optimization is compatible with CMYK and CMYK+X media profiles.

¢ Optimize a device link (Iterative match to a standard) - Matches the output of your Fiery-driven printer to an
industry reference (for example, PSO Coated). Fiery Optimizer a device link profile using a CMYK source profile
and an output profile on the Fiery server as the destination profile. Using measurements of color sample patches,
converted with the device link profile being created, Fiery Optimizer can optimize the device link profile to
better match the color appearance of the industry press reference. With repeated iterations of device link profile
tuning, and measuring results from printed color patches, you can optimize the appearance match. Fiery
Optimizer installs the profile on the Fiery server.

e Create a custom device link - Creates a device link profile from specified source and destination profiles.
Optionally, you can include one or two intermediate profiles. You can save the resulting profile or install it on a
Fiery server.

Optimize a media profile (iterative match to a standard)

Sometimes the use of a custom output profile in conjunction with a reference CMYK profile, such as ISO Coated,
does not result in a close enough match for some production requirements. To more closely match a Fiery-driven
printer to a CMYK reference, an optimized media profile is sometimes used instead.

Be sure that a CMYK source profile that simulates the reference is installed on the Fiery server. Use Fiery Printer
Profiler to calibrate and profile the Fiery server before you create the Fiery Optimizer profile.

Fiery Optimizer creates a media profile and lets you improve the match to the reference by printing sample patches
and optimizing the color match in the media profile based on these measurements. You can repeat the printing and
measuring of the patch page to progressively fine-tune the optimization with each iteration. Fiery Color Profiler
Suite supports only CMYK output profiles for media optimization.



Fiery Color Profiler Suite Help 53
Fiery Optimizer

If iterative optimization does not result in printed colors that more closely match the standard, it might be for one of
the following reasons:

H W N
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The printer is not performing up to its capabilities (not reaching the maximum toner or ink densities).
The printer is not capable of printing to the target standard even performing at its best. The colors in the

standard are out of the gamut of the printer.

In Fiery Color Profiler Suite, click Optimize.
Click Media profile optimization (Iterative match to a standard) and click Next.
Select the Fiery server.

Select a source profile that is associated with the target standard (for example, ISO Coated), select the new
output profile that you created in Fiery Printer Profiler, and click Next.

Note: A copy media profile is created if you attempt to optimize a factory default media profiles.

Follow the on-screen instructions to print and measure a patch page using the spectrophotometer.

Choose the instrument to measure the patches. To measure pages, click the measurement instrument in the
Instrument menu.

Select a Patch Layout setting. Fewer patches are faster to use, but more patches generally produce higher quality
results. For the best quality and results, select the recommended Fiery Edge patch layout chart. You can also
choose from alternative chart layouts if a custom patch layout chart is needed.

For chart size, pick your paper size. Select a setting in the Paper Size list for printing the measurement page or
click Custom and specify a custom page size.

Click Print and configure any media settings (paper and tray). You do not need to configure color settings as they
will be overridden.

When the measurement results are displayed, click Iterate to further optimize the profile if you are not satisfied
with the results.

With each iteration, you print a patch page using the optimization from the previous iteration and measure the
page to determine how closely the colors match the standard.

Continue to print and measure patch pages until the measured Delta E values are within your desired tolerances.

If an iteration results in higher Delta E values, delete the iteration and proceed with saving the profile.

Click Next to name the new profile, and then click Next to install the profile on the Fiery server with the
associated profile settings.

Click Done to close Fiery Optimizer.

If you would like to optimize the media profile (such as for recalibration when color matching fails), you can perform
this procedure again, selecting the same profile to edit rather than creating a new one.
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Optimize grays after profiling

Sometimes the use of a custom output profile in conjunction with any targeted gray profile, does not result in a close
enough match for some production requirements. To more closely match a Fiery-driven printer to a gray reference,
an optimized media profile is sometimes used instead.

Be sure that a gray source profile that simulates the reference is installed on the Fiery server. Use Fiery Printer
Profiler to calibrate and profile the Fiery server before you create the Fiery Optimizer profile.

Fiery Optimizer creates a media profile and lets you improve the match to the reference by printing sample patches
and optimizing the grayscale match in the media profile based on these measurements.

1 In Fiery Color Profiler Suite, click Optimize.

2 Click Media profile gray optimization and click Next.
3 Select the Fiery server.
4

Select a source profile that is associated with the target standard, select the new output profile that you created in
Fiery Printer Profiler, and click Next.

Note: A copy of the media profile is created if you attempt to optimize a factory default media profile.

5 Follow the on-screen instructions to print and measure a patch page using the spectrophotometer.

Note: If the calibration of a job is outdated, you must recalibrate the Fiery server before applying gray
optimization.

Choose the instrument to measure the patches. To measure pages, click the measurement instrument in the
Instrument menu.

The Gray optimization chart option is selected as the Patch Layout setting.

For chart size, pick your paper size. Select a setting in the Paper Size list for printing the measurement page or
click Custom and specify a custom page size.

Click Print and configure any media settings (paper and tray). You do not need to configure color settings as they
will be overridden.

6 If the gray balance profile creation is successful, your profile will be saved and you can click Exit to close Fiery
Optimizer.
If your measurement results differ significantly from the profiling chart measurement, click Done to close Fiery

Optimizer. You must check your printer status and try the optimization process again later.

If the gray balance in your media profile is accurate, optimization will not be applied, and you can click Exit to
close Fiery Optimizer.

If you would like to optimize the media profile, you can perform this procedure again.

If you choose to verify an optimized profile that was copied from a factory default media profile, you must click Edit
next to Job properties preset and specify custom job properties, such as a source profile or an output profile, in
Fiery Verify Assistant. Otherwise, the default job properties preset on the Fiery server are used, and the verification
may not be completed correctly.
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Optimize a device link (iterative match to a standard)

Sometimes the use of a custom output profile in conjunction with a reference CMYK profile, such as ISO Coated,
does not result in a close enough match for some production requirements. To more closely match a Fiery-driven
printer to a CMYK reference, an optimized Device Link profile is sometimes used instead.

Be sure that a CMYK source profile that simulates the reference is installed on the Fiery server. Use Fiery Printer
Profiler to calibrate and profile the Fiery server before you create the Device Link profile.

Fiery Optimizer creates a Device Link profile and lets you improve the match to the reference by printing sample
patches and optimizing the color match in the Device Link profile based on these measurements. You can repeat the
printing and measuring of the patch page to progressively fine-tune the optimization with each iteration. Fiery Color
Profiler Suite supports CMYK and multicolor (CMYK+X) output profiles for device link optimization.

If iterative optimization does not result in printed colors that more closely match the standard, it might be for one of
the following reasons:

o The printer is not performing up to its capabilities (not reaching the maximum toner or ink densities).
o The printer is not capable of printing to the target standard even performing at its best. The colors in the

standard are out of the gamut of the printer.

1 In Fiery Color Profiler Suite, click Optimize.
2 Click Optimize a device link (Iterative match to a standard) and click Next.
3 Select the Fiery server.

4 Click Create a new device link profile, select a source profile that is associated with the target standard (for
example, ISO Coated), select the new output profile that you created in Fiery Printer Profiler, and click Next.

5 Click Next to accept the default settings.

If you want to customize the settings, use the following guidelines.

* For rendering intent, set relative colorimetric for color production workflows or absolute colorimetric for
proofing workflows (paper white will be simulated on the output). Set the Black point compensation option
to Auto-detect.

¢ Ifyou wish to print gray using black only to avoid color clicks for black-and-white pages, select Preserve gray.

e The Preserve gray setting is not recommended for precise color matching.

6 Follow the on-screen instructions to print and measure a patch page using the spectrophotometer.

Choose the instrument to measure the patches. To measure pages, click the measurement instrument in the
Instrument menu.

Select a Patch Layout setting. Fewer patches are faster to use, but more patches generally produce higher quality
results. We recommend 89-1617 patches.

For chart size, pick your paper size. Select a setting in the Paper Size list for printing the measurement page or
click Custom and specify a custom page size

Click Print and configure any media settings (paper and tray). You do not need to configure color settings as they
will be overridden.
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7 When the measurement results are displayed, click Iterate to further optimize the profile if you are not satisfied
with the results.

With each iteration, you print a patch page using the optimization from the previous iteration and measure the
page to determine how closely the colors match the standard.

8 Continue to print and measure patch pages until the measured Delta E values are within your desired tolerances.

If an iteration results in higher Delta E values, delete the iteration and proceed with saving the profile.

9 Click Next to name the new profile, and then click Next to install the profile on the Fiery server with the
associated profile settings.

10 Click Done to close Fiery Optimizer.

If you would like to optimize the Device Link profile (such as for recalibration when color matching fails), you can
perform this procedure again, selecting the same profile to edit rather than creating a new one.

Create a custom device link profile

When you create a custom device link profile, you select the source and destination profiles. If you want to convert
source colors to one or two intermediate color spaces before conversion to the target color space, you can also select
one or two intermediate profiles.

1 Click Create a custom device link in the Welcome window, and then click Next.

2 Under Select source profile, click the File icon #; and select a source profile.

3 Under Select destination profile, click the File icon #; and select an output profile.

4 To add an intermediate profile, click Insert Intermediate Profile and select the intermediate profile.
5

To add a second intermediate profile click Insert Intermediate Profile and select the second intermediate profile.

Specify device link profile settings in Fiery Optimizer

When you create a device link profile using Fiery Optimizer, you set rendering intent and separation options that
affect how Fiery Optimizer maps color values from source to destination. Fiery Optimizer uses these settings to
create the device link profile.

¢ Black point compensation - Scales the black point of the source color space to fit the range of lightness in the
output profile, rather than clipping. This preserves black gradients, such as shadows. Black point compensation
applies only to the Relative Colorimetric rendering intent.

Click Auto-detect to apply black point compensation only when the source black point is lower (darker) than the
destination black point. Click Always to always apply black point compensation.

¢ Preserve gray - Preserves RGB gray (R=G=B) or CMYK gray (CMY=0, K not zero) in the source and does not
convert to black-only.

1 Select the Rendering Intent to use between each linked profile. If you are matching to a standard, select Relative
Colorimetric unless you want to print paper white simulation (for proofing).

2 Set the separation options as they apply to your device link profile.
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Print patch pages for optimization

When you optimize a device link profile or a media profile using Fiery Optimizer, you print pages that contain
patches of various colors and measure the patches with an instrument.

Alternatively, you can load existing measurements.

Note: Before printing a measurement page, you can set print options and other settings for sending the job to the
printer. Do not change any color management settings.

1 Connect the measurement instrument to your computer.
2 Do one of the following:
¢ To measure pages, click the measurement instrument in the Instrument menu.

¢ To load measurement data from a file, click Load measurements, and then click Next.

3 Optionally, if you are measuring pages, click Settings and specify the instrument’s settings.
4 Select a Patch Layout setting if it is available.
Fewer patches are faster to use, but more patches generally produce higher quality results.

5 Select a setting in the Paper Size list for printing the measurement page or click Custom and specify a custom
page size.

6 Click Next to print the measurement page.

Check Fiery Optimizer measurement results and iterate

After you measure a measurement page to optimize a device link profile or a media profile, information about the
measurements and the expected values appears. If you are not satisfied with the results, you can iterate (print and
measure another page).

Calculated dE (Delta E) values compare measurement values with expected values. For a device link profile or a
media profile, the standard (CMYK source profile) are the expected values.

For multiple iterations, dE values for all previous measurements appear so that you can see if the match is
improving. You may want to delete an iteration if the results do not show any improvement.

1 Do one of the following:

e If the dE values are acceptable, click Delete next to any iteration that you want to delete, and then click Next to
continue and save the results.

e If dE values are unacceptable, click Iterate to print and measure again to further optimize the match.

2 To view spot color measurements in Verifier, click View.
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Save and install device link profiles

Fiery Optimizer lets you process, save, and install the device link profiles on a Fiery server. If you are not creating a
device link profile to match to a standard, you can save the device link profile locally.

When you create a device link profile on a Fiery server, Fiery Optimizer automatically sets the profile association
settings. These settings determine how the job enables the device link profile.

If a job specifies the associated source profile as its CMYK Source Profile or RGB Source Profile and the associated
destination profile as its Output Profile, the device link profile is enabled for the job.

If an associated source profile or destination profile does not already reside on the Fiery server, it is installed along
with the device link profile, so that it can be selected to enable the device link profile.

1 Type a description for the profile.
2 Optionally, type additional information under Comments.
3 Do one of the following:

¢ Ifyou are not creating a device link profile to match to a standard, click Install on Fiery Server and select the
Fiery server from the list.

¢ If you want to save the profile locally, click Save on local drive.

Note: If you are creating a device link profile to match to a standard, the profile is installed on the Fiery server
that you selected previously.

4 C(Click Next.

5 Ifyou are saving the profile locally, navigate to the new profile’s location, type a file name, select the ICC profile
type (v2.0 or v4.0), and then click Save.

Note: The default location for profiles is the folder where the operating system installs profiles.

View device link profile information

After you create a device link profile, Fiery Optimizer displays information about the profile.

o Ifthe profile was installed on a Fiery server, the server name and the associated profile settings appear.
o Ifthe profile was saved to the local computer, the file name and a link to the file location appear.

e Ifyou optimized spot colors, information about the spot colors appears in Fiery Optimizer.

You can also print a sample page.

» Click Print to print a sample page with the optimized spot colors.
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Fiery Print Matcher

Fiery Print Matcher helps obtain consistent color output across a group of up to five Fiery-driven printers. Color
results depend on different factors, but Fiery Print Matcher uses the Fiery server color management features to help
minimize these differences.

Note: Each Fiery server must be running Fiery system software FS200/200 Pro or later.

Fiery Print Matcher provides different methods for matching printers, depending on the characteristics of the
printers.

e Common calibration and output profile - For printers of the same make and model. The calibration curves of
these printers are similar enough that Fiery Print Matcher can create a calibration goal and output profile that
are common to all the printers.

e Device link profiles - For printers of different models or manufacturers. Device link profiles map each printer’s
output color space to the common color space between the printers.

Using measurement data from all selected printers, Fiery Print Matcher generates either a calibration and an output
profile or a device link profile. When you use the calibration and output profile or the device link profile to print a
job, you can print to any of the printers with similar color results.

Note: Fiery Print Matcher is not available in Demo mode.

Create a common calibration and output profile

For printers of the same model, Fiery Print Matcher uses color measurements from all of the printers to create a
common calibration goal and output profile. For a new common calibration, you measure calibration pages and
profiling pages, then create a common calibration goal, and then print and measure profiling pages for each Fiery
server in the list.

e A calibration goal specifies the target density values for a Fiery server. The calibration goal specifies the
maximum densities of C, M, Y, and K that all of the printers can print.

e The output profile represents the common color space between the printers. In other words, the output profile
specifies only the colors that all of the printers can print.

You specify which printers to match by adding to the Fiery server list during a session and giving the session a name.
You use the session name if you update the calibration later. (If you update an existing calibration, you cannot change
the list or the session name.)

You can specify just one printer if you want to create a new calibration using a measurement instrument that Print
Matcher supports instead of matching printers.

Print Matcher installs the resulting calibration goal and output profile on each Fiery server.

Note: You can exclude the measurements of one or more printers when calculating the calibration goal. Excluded
printers are not profiled. If you exclude a printer from the common calibration, you can include it when you update
the common calibration.
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In the course of the common calibration workflow, a CMYK source profile is also specified. At the conclusion of the
common calibration workflow, a server preset is created on each Fiery server. The server preset can be selected to
print with the common calibration, output profile, source profile, and all print settings used to create the output
profile.

Create a new common calibration

Creating a new calibration starts with naming the session, choosing each Fiery server, and printing a page that you
can use to measure the printer’s current color output (the maximum densities of C, M, Y, and K).

1 Click Printer Match in the Fiery Color Profiler Suite window.

2 Click New common calibration, and then click Next.

3 Type a name for this session.

4 Click the plus sign (+) to add each Fiery server for each printer that you want to match.
5

If you wish to conduct G7 calibration, select the check box.

The G7 gray balance calibration target check box is not selected by default.

6 Select a CMYK source profile from the list and click Next.

CMYK source profile will be used to create server preset and to print profile test page.

7 In the Calibration print settings window;, specify the calibration chart you wish to use, page size, and
measurement instrument, and click Next.

8 Specify settings for printing the calibration job and click Print.
9 Retrieve the printed calibration page and follow the on-screen instructions to measure the page.

Note: You can save the measurements, quit Print Matcher, and then resume this procedure later. Use Resume
measuring session when you restart Print Matcher.

10 Print and measure a calibration page for each additional Fiery server that you are matching.

Review calibration results

After you review calibration measurements, you can repeat measurements or exclude measurements from the
calibration calculations.

Print Matcher does not install the common calibration goal and common output profile on an excluded Fiery server.
If you exclude a printer from the common calibration, you can include it when you update the common calibration
at a later time.

1 Review the calibration results, and click Next.

2 Ifany results are questionable, click Reprint next to the results to reprint and remeasure a calibration page for the
specific Fiery server.
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3 If desired, adjust the control for Enhance common calibration stability.

This control will reduce the target densities by up to 5% so that if you are matching new printers you can add a
small gamut reduction to make sure the printers continue to match as they age. The recommended stabilization
setting is 2%.

4 (Optional) If any results are out of the expected range after you repeat the measurement, exclude the Fiery server
by clearing the Include check box next to the results.

Create a common output profile

After creating the common calibration and reviewing the results, continue to create the common output profile.
If any results are questionable after you review the results, you can reprint the pages and measure again.
After you save the profile, Fiery Print Matcher installs it on each Fiery server.

1 Specify settings for the profiling pages, and then click Next.

Profiling pages are printed with the common calibration applied.
2 After the profiling job is printed, click OK.

3 Retrieve the profiling pages from the printer and follow the on-screen instructions to measure the pages.

Note: You can save the measurements, quit Fiery Print Matcher, and then resume this procedure later. Use
Resume measuring session when you restart Fiery Print Matcher.

4 Print and measure profiling pages for each additional Fiery server that you are matching.

5 Review the profiling results, and then click Next.

Profiling pages include multiple patches of the same color. The dE average and dE maximum values (Delta E)
summarize the variation in measurements of the same color.

You can click Inspect measurements to look at the measurement data in Profile Inspector.
6 In the Apply Settings window, import settings from an existing profile, and then click Next.
For more information about importing settings, see Load settings on page 34.
7 In the Save Profile window, specify the profile description, media, and any comments desired. Click Next.

By default, the profile description is the name of the printer matching session.

8 To check your printer matching results, click Test Print to print a color test page to each Fiery server.

Update a common calibration

A printer’s color output can change over time, so you must update a common calibration periodically to keep the
color output consistent. If color consistency is important, we recommend calibrating your Fiery server at least once a
day. You can recalibrate matched printers individually from Command WorkStation or Fiery Color Profiler Suite
Calibrator, or you can use the Update common calibration setting described here.

1 Click Printer Match.
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2 Click Update common calibration, click the printer matching session in the list, and then click Next.
3 If necessary, click Update to reconnect any disconnected Fiery server in the list, and then click Next.

4 Specify the calibration page settings, and click Next.

Use the same settings that you used when you created the common calibration.

Specify settings for submitting the calibration job to the specified Fiery server and click Print.

Retrieve the calibration page from the printer and follow the on-screen instructions to measure the page.
Print and measure calibration pages for each additional Fiery server that you are matching.

Review the calibration results, and then click Next.

O O N & U

Click Test Print to print a color test page to each Fiery server, and check the printer matching results.

Create a new common device link profile
When printers are of different manufacturers or different models, Fiery Print Matcher can create a device link profile
for each printer that you want to match.

Before you use this method, calibrate each Fiery server and check that the measured data for each printer closely
matches its target densities. If any profile does not produce acceptable color, create a new profile using Printer
Profiler.

Print Matcher uses output profile data from each printer to calculate a gamut that is common to all printers. When
one of the printers prints the job, it uses only those color capabilities that are common to all printers, regardless of
the individual printer’s capabilities.

This method uses an existing output profile from the Fiery server associated with each printer. The output profile
from each Fiery server is the intermediate profile in its device link profile. The destination in all of the device link
profiles is the common color space between the printers. The resulting device link profile is installed on each Fiery
server.

1 In Fiery Color Profiler Suite, click Printer Match.
2 Click New device link, and then click Next.

3 Type a name for this session, click the plus sign (+) to add each Fiery server for the printers that you want to
match, and then click Next.

4 Select a source profile.

A device link profile will be created for each printer. Each device link profile will use this source profile. Select the
CMYK source profile that you prefer for printing most jobs.

5 For each Fiery server, select the output profile that you created, and then click Next.

In each device link profile, the profile of the printer being matched is used as an intermediate profile, and the
common color space is the destination.

6 In the Apply Settings window, select the profile settings and click Next.
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7 In the Save Profile window, specify the profile description and any comments desired for each device link profile,
and then click Next.

The device link profile for each Fiery server is installed on the corresponding Fiery server and is associated with
the source profile and output profile settings that match the profiles used to create the device link profile.

8 To check your printer matching results, click Test Print to print a color test page to each Fiery server.

Print calibration pages

The Calibration print settings window lets you specify calibration pages.

Fiery Print Matcher lays out color patches on the calibration page according to the measurement instrument and
paper size that you specify. You can also set the number of warmup pages to print.

1 In the Instrument menu, click the measurement instrument to use.
2 (Optional) To make specific settings for the instrument, click Settings.

3 Click Set number of warmup pages and then set a number.

Print profiling pages

Fiery Print Matcher lays out color patches on measurement pages depends on the measurement instrument, patch
layout, and paper size that you specify.

Patch layouts differ by the number of patches. Some are based on ICC standard targets.

You can also set the number of warmup pages to print. (Warmup pages are extra copies of the profiling pages that
you can discard.) We recommend that you measure the next-to-last copy printed.

1 In the Instrument menu, click the instrument to use.
2 (Optional) To make specific settings for the instrument, click Settings.
3 Click a patch layout in the Patch layout menu.

* Recommended

e A recommended Fiery Edge patch layout chart is listed. When listing the recommended patch layout chart,
Fiery Color Profiler Suite considers your measurement instrument, sheet size, and calibration set. The
number of patches and expected pages will be displayed.

¢ Fiery Edge alternatives

¢ Dynamically generated patch layout charts are listed in order of the number of patches. You can choose
from four patch layouts.
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¢ Industry Standard

¢ IT8.7/5 (1617 patches) - The 1617 target is a CMYK printer characterization target combining the unique
patch values in the standard 1T8.7/4 target with all the patch values in columns 4 and 5 of the P2P51 target.

e IT8.7/4 (1617 patches) or IT8.7/4 (1617 sorted layout) - Are similar to the 928-patch layouts but provide
more data. The sorted layout helps to reduce potential bias caused by color variation across the page.

4 Click Set number of warmup pages and then set a number.

Specify output profile settings

You can set the gamut mapping, separation settings, profile optimization, and viewing condition for the output
profile.

¢ For gamut mapping options, see Set gamut mapping on page 35.

o For separation options, choose the factory profile from one of the Fiery servers for a paper like the one you are
profiling (coated, uncoated). This will load the profile settings that were used to create the manufacturer-
approved factory profile.

Set profile optimization

The Optimize colorimetric precision option uses optimization to improve colorimetric precision and reduce dE
(sometimes referred to as AE or Delta E) values.

« In the Apply settings window, click Optimize colorimetric precision (Recommended for proofing workflows).

Set viewing condition

You can set the color of ambient light in which prints are intended to be viewed. It is recommended to leave this
option set to D50 and always evaluate color quality visually in a D50 light booth.

« Inthe Apply settings window, do one of the following:
¢ Click a setting in the Lighting value list.

¢ Click the plus sign (+) to create your own setting, either by using a measurement instrument or by specifying
the XYZ value.

Specify device link profile settings

In Print Matcher, you can specify and settings for rendering intent and separation options for the device link profile.
These settings affect how color values are mapped from source to destination.

Separation options affect how the C, M, Y, and K components of the output are determined.
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Black point compensation scales the lightness of all input colors to fit the range of lightness in the output profile,
rather than clipping values outside of the range. This adjustment preserves black gradients, such as shadows.

1 Set the rendering intent to use for each link:
¢ Source - Maps source colors to the intermediate profile (the output profile of the specific Fiery server).
¢ Output - Maps colors from the intermediate profile to the destination (common gamut).

2 Set Black point compensation:

¢ Auto-detect - Applies Black point compensation only if the input black point is lower (darker) than the output
black point. For the Absolute Colorimetric rendering intent, this is the only setting available.

¢ Always - Applies Black point compensation always.
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Fiery Profile Inspector

Fiery Profile Inspector provides an environment for inspecting RGB, CMYK, and named color profiles, displayed as
two-dimensional or three-dimensional models in Lab color space. You can display multiple profiles (maximum of
five) in contrasting colors for easy visual comparison.

Profile Inspector offers various display styles for profile models and tools for manipulating the models and the
environment. You can also view specific color information about the profiles.

Profile Inspector can display data from a measurement file (IT8) plotted in Lab color space. You can also plot
individual color measurements taken with a measurement instrument.

Display profiles

You can display the gamut of one or more profiles (maximum of five) in the modeling area, rendered in Lab color
space. Controls let you adjust the background, lighting, opacity, and point size. In particular, you can display multiple
models in contrasting colors.

1 Do one of the following:

¢ Click File > Open, and click the profile.

¢ Drag an ICC profiles from the desktop to the modeling area.

2 Adjust the controls to view the features of the profile model.

3 To show or hide a profile model, click the check box next to the profile name in the list.

Work with profile models in Profile Inspector

You can rotate, select points in, zoom, and display an interior cross-section of a model. You can also reset a model to
its default position.

Reset a profile model to its default position

You can reset a profile model to its default position.

+ Click the Home icon ).
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Rotate a profile model
You can rotate a model horizontally, vertically, or in all three dimensions.
1 Click the Rotate icon [
2 Do one of the following:
¢ To rotate the model in three dimensions, click the model off center and drag.
e To rotate the model around the horizontal axis, use the scroll wheel
¢ To rotate the model around the vertical axis, press the Ctrl key and use the scroll wheel.

¢ To rotate around the L axis, press the Shift key as you drag the model.

Note: On macOS, Horizontal and Vertical scrolls on a mouse that supports these options rotate the model
horizontally and vertically, respectively.

Zoom a profile model
You can zoom in and out of a profile model.
1 Click the Zoom icon [« .
2 Do one of the following:
e To zoom in, click the model.
¢ To zoom out, Alt+click (Windows) or Option+click (macOS).

¢ To zoom a section of the model, drag to create a rectangular area.

Note: To zoom without clicking the Zoom tool, press Ctrl+= or Ctrl+_.

View an interior slice of a model

The Clip tool lets you pass an invisible vertical plane through the model from front to back, cutting away the portion
it passed through. This creates a cutaway view of the model, which is useful when comparing two profiles.

1 Click the Clip icon [*.

2 The first time you use the Clip tool, click to reveal the clipping plane, and then drag up or down to make the
clipping plane larger or smaller.

3 After the first time you use the tool, you can do either of the following:

¢ To display the clipping plane, click near the bottom of the modeling area and drag up. (You may have to do this
several times before the clipping plane appears.)

¢ To move the clipping plane out of the model, click in the modeling area and drag down.
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Select points in a profile model

You can choose points to display their color coordinates in the Measurements area. Profile Inspector inverts the
selected point's color to indicate that it is selected.

1 Click the Select icon [

2 Click the point that you want to select.

Set environment and display style for profile models

You can adjust the background, lighting intensity and display styles for profile models. For display styles, you can set
how Profile Inspector plots the model, its color, rendering internet, opacity, and point size.

Note: Background, lighting, how to plot the model, and opacity are unavailable for 2D models.
« Setany of the following options:

¢ Background - Sets the lightness of the background and the model’s saturation.
¢ Lighting - Sets the intensity of the lighting. When Lighting is off, the model appears flat (no shading).
* PlotAs

Surface - Displays the profile as a three-dimensional shape with a continuous surface.

Slice - Displays the profile as a set of two-dimensional surfaces extending from the neutral axis through the
primary and secondary hues.

Edges - Displays the profile as the outlines of portions of the profile through the primary and secondary hues
as well as the neutral axis.

Points - Displays all input value points.

Outline - Displays profile as outlines of the surface polygons. This is similar to the Surface model, but the
polygons are not filled in.

Surface + Points - Displays profile as a combination of the Surface and Points models.

¢ Color - True Color displays actual colors in their correct locations. Other selections display the entire model in
one color.

Note: When you compare the gamut of two profiles, you can see the differences more clearly if you display the
profiles in contrasting colors.

¢ Rendering Intent - The ICC specification defines several ways of mapping colors from one color space to
another, called rendering intent. A profile contains data for multiple rendering intents.

¢ Opacity - Makes the profile model more or less transparent.

¢ Point Size - Changes the points’ display size.
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Display measurements from a file

You can display the measurements in an IT8 file (maximum of five files) in the modeling area, plotted in Lab color
space. This allows you to compare the measurements with an existing profile.

1 Under Measurements, click the plus sign (+) and then click the file.

2 To show or hide the measurements, click the check box next to the file name.

Point information

When you select a point, Profile Inspector displays color information for the point in the lower right corner of the
window.

The point information includes:
e Description - An internal description of the profile that contains the point.
¢ Plotted - The Lab value for the selected point.

Profile Inspector plots the model in Lab space.

¢ Input - The device-dependent color value associated with the Lab value. The value may be CMYK, RGB, or a
string value, depending on the color space of the selected profile.

Measure a color with an instrument

With a measurement instrument (such as the Fiery spectrophotometer) that can measure a single color sample, you
can measure a color and display the point in the modeling area.

Before you measure a color, you calibrate the instrument and then measure the color. When you measure a color, the
Lab values appear in the lower right corner of the window and the measured point appears in the modeling area.

1 To calibrate the measurement instrument, click Instrument > Calibrate.
2 Select your desired measured mode from the list and then click Calibrate.
Place the instrument on the color you want to measure, and press the button on the instrument.

To measure another color, place the instrument on the new color, and press the button on the instrument.

i » W

To remove a measured point from the modeling area, select Instrument > Remove Point.
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Fiery Profile Editor

Fiery Profile Editor lets you modify an existing CMYK or RGB output profile.

o The reference image shows the effects of editing the profile. You can use the default image or select your own.
o The Color Information pane displays the source-to-output mapping of a selected color.

o The Rendering Intent menu shows which rendering intent is currently selected for editing.

Open a profile for editing
You can open a profile for editing at any time. The Editing Profile field displays the file name of the profile currently
open for editing.

You can select a profile of the Output class in either the CMYK or RGB color space to edit.
1 Do one of the following to open a profile for editing:

¢ Click File > Open Profile for Editing or File > Recent Profile.

¢ Dragan ICC profile directly to the Profile Editor window.

2 Ifyou are selecting a profile, select the location from which to search for profiles.

3 Click the profile and then click Select.

Select rendering intent

An output profile contains data for several rendering intents. When you edit a profile, the edit applies to a specific
rendering intent. Be sure that you select the desired rendering intent before making an edit.

You can change the default rendering intent when you save a profile.

Profile Editor allows you to copy an edit from one rendering intent to another.

Depending on how a profile was created, it might share data between multiple rendering intents. In this case, an edit
in one rendering intent necessarily affects the rendering intents that share common data. Profile Editor informs you
if rendering intents share data when you change the Rendering Intent setting.

Absolute Colorimetric and Relative Colorimetric rendering intents always share data. An edit that you make in the
Absolute Colorimetric intent is automatically duplicated in the Relative Colorimetric intent and vice versa.

The Absolute Colorimetric rendering intent is the only one that specifies the media whitepoint. Therefore, when you
select the Media Whitepoint tool, the Absolute Colorimetric intent is automatically selected.

+ Click a rendering intent in the Rendering Intent menu.
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Save a profile in Profile Editor
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When you save an edited profile, you can specify the profile’s default rendering intent and its profile descriptor. You

can also flatten the profile and either install it on a Fiery server or save it to your local computer.

Note: By default, Profile Editor saves an edited profile with a new file name, preserving the original file.

The profile descriptor is the profile’s name that appears in an application. For example, a program that lets users
select from a list of profiles displays the profile descriptors of the available profiles.

Flattening the profile simply removes extra data that only the Profile Editor uses. You can flatten a profile if you do
not intend to edit it again. If you do not flatten a profile when you save it, Profile Editor stores the profile’s edit list

inside a private tag. An unflattened profile is fully ICC-compatible and you can used it the same as a flattened profile.

Note: You cannot undo flattening. We recommend that you keep a copy of the unflattened profile.
1 Do one of the following:

e Type a new profile descriptor directly in the Name your profile field.

¢ Click Options, then type a new profile descriptor, or click an Edit Version icon (ws w#) to change the edit

version suffix.
¢ To add a new profile descriptor, click the Add icon (+) and double-click any field to type a new value.
Click a rendering intent in the Rendering intent list.

(Optional) Type additional information under Comments.

H W N

(Optional) Click Flatten Profile.

5 Do one of the following:
¢ To install the profile on a Fiery server, click Install on Fiery Server and click the Fiery server in the list.
¢ To save the profile locally, click Save on local drive.

6 Click Save.

7 Do one of the following:

¢ Ifyou install the profile on a Fiery server, specify the profile settings and click OK.

¢ If you save the profile locally, navigate to the location in which you want the profile saved, and click Save.

Output profile settings

You can specify the settings of an output profile when you import it to a Fiery server. In the Profile Settings dialog

box, select the settings as needed.

Media Type lets you specify the profile’s media settings. When a job is configured to use the output profile defined

by its media settings (the media-defined profile) and the job has one of the selected media settings, this profile is
used to print the job.
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You can associate a calibration with more than one output profile. However, the calibration data for any existing
calibration might not be appropriate for your profile. In this case, use Calibrator in Command WorkStation to create
a new calibration, associate it with your profile, and calibrate to get new measurement data.

Reference image
The reference image shows how the edited profile affects color output. Profile Editor can display three different views
of a reference image (source, original output, and edited output).

The two sample reference images consist of multiple images containing a variety of image types and color values.
Color swatches in the reference images include primary colors, neutral tones, and some common “memory” colors,
such as sky blue and grass green. The images are in the Samples/Images folder in the Fiery Color Profiler Suite
installation directory.

Note: The color swatches are static and do not change to show the effects of the edited profile.

You can use any CMYK or RGB image in JPEG or TIFF (8-bit or 16-bit) file format as a reference image. Profile
Editor uses the source profile you specify to interpret the image’s colors.

Reference image tools

Profile Editor provides tools for changing or using the reference image.

Icon | Name Keyboard shortcut | Description

i Eyedropper | Ior CtrlI Click a color in the image or color bar to display in the Color Information pane.
The Eyedropper tool also changes the source color for the Selective Color, Hue
Edit, and Node Edit tools.

® Roam M or Ctrl M Drag to slide the image quickly in a particular direction. Use the Roam tool to
move from one edge of the image to another when the image is too large to fit
inside the pane.

W Move Hor Ctrl H Drag to move the image around. Use the Move tool to bring a part of the image
into view when the image is too large to fit inside the pane.

SN Zoom Zor CtrlZ Click to zoom in (enlarge the image size). Alt+click (Windows) or Option+click

(macOS) to zoom out (reduce the image size). Drag to define a rectangular area
to enlarge.

If your mouse has a scroll wheel, you can zoom in by moving the wheel one way
and zoom out by moving it the other way.

Ctrl+= and Ctrl+_ zoom in and out respectively, even if the Zoom tool is not
selected.

- Fit Width w Click to resize the image to fit the width of the pane.

5 Fit Window | Windows: Ctrl+0 Click to resize the image to fit the entire image inside the pane.
(zero), macOS:
Command+0 (zero)

(g} Rotate R Click to rotate the image 90 degrees clockwise.
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Open a reference image file

You can select the reference image. You can display the reference image using its embedded profile if it has one.

You can also select a different profile for an image that has an embedded profile. This is useful if you intend to
represent the image using a different source profile. If you do not know which source profile to use, you can select
different profiles and compare the results.

1 Click File > Open Reference Image, click the file, and then click Open.

2 To display the image using its embedded profile, click Keep embedded profile.
Note: This option is available only if the image has an embedded profile.

3 Ifthere is no embedded profile, click Select source profile and locate the file,

4 Click the profile, and then click Select.

Select source profile to display reference image

You can change the source profile used to display the reference image.

You can select a source profile of the Input, Display, or Output class to render the reference image. The color space of
the source profile must match the color space of the reference image.

1 Click File > Select Source Profile.
2 To display the image using its embedded profile, click Keep embedded profile and then click OK.
Note: This option is available only if the image has an embedded profile.

3 To use a different profile or if there is no embedded profile, click Select source profile and click Browse. Click the
profile, and then click Select.

Preview output media color

The Preview Output Media Color option displays the reference image using the color of the output medium (or
substrate) simulated. The display shows paper white according to the profile’s media whitepoint of the profile.

You can select this option in any rendering intent. Selecting Absolute Colorimetric rendering intent automatically
selects Preview Output Media Color because you can edit the media whitepoint only in the Absolute Colorimetric
rendering intent.

Note: The Preview Output Media Color option does not provide an accurate soft proof, only an approximation of
the printed colors and the media color.

» Click Preview Output Media Color.
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View source, original output, and edited output views

Profile Editor lets you view the reference image as the source, output, or edited output.
+ Click one of the following:
¢ Source (4) - Displays the image using the selected source profile.

¢ Output (Original) (O) - Displays the image as it would appear printed using the output profile without any
edits.

¢ Output (Edited) (M) - Displays the image as it would appear using the output profile with edits.

Display color information for a source color

The Color Information pane displays a color swatch and numerical color values for one source color and its
corresponding colors in the original and edited profiles.

The calculated numerical differences between the colors appear above the swatches.
The selected color is also the source color for the Selective Color, Hue Edit, and Node Edit tools.

« To select a source color, do one of the following:

¢ Use the Eyedropper tool (_#) to sample a color in the reference image.
¢ Type values in the source fields.

¢ Click the measurement instrument icon (%#) and sample the color of a physical object using the
spectrophotometer.

Set the color model for representing color values

You can set a different color model to represent the numerical color values in the Color Information pane. When you
change color models, Profile Editor calculates and displays the equivalent values for the same color.

These icons indicate the current color model:
e & -Sets CMYK.

e ® -Sets RGB

e M -SetsLab

o L -SetsXYZ

1 Click the icon for the color model.

2 Click the color model that you want in the list.
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Set method for calculating Delta E

You can set the method for computing the Delta E between the source, original output, and edited output colors.
Choose the method most familiar to you.

The numerical difference between any two colors is called Delta E (AE or dE).

Individual colors are not distributed linearly across a color space. When the Delta E of two colors is computed by
simple subtraction, the same numerical value can represent a very different visual difference, depending on the
region of the color space where the two colors are located. There are a number of established methods for calculating
Delta E that apply different approaches to make the numerical differences correspond to the visual differences.

The most commonly used method for calculating Delta E is Delta E*ab, which is the default method. This method is
the simplest to calculate. The other methods (Delta E 94, Delta E 2000, and Delta E CMC) are more complicated to
calculate but are better at reflecting the visual differences between colors. The Delta E 2000 method is the most
modern method.

1 Click the Delta-E Coordinates icon (&5).

2 Click the method in the list.

Edit colors and the Edit List

The Edit Tools pane lets you edit colors and view or change the list of edits already created. The Edit List displays, for
the selected rendering intent, the edits that have been made.

The Edit List displays edits in the following order, which is the order in which they are applied:

e Media Whitepoint edit (Absolute Colorimetric rendering intent only)

e Global Color edit (one per rendering intent)

e Hue edits, in the order created

e Selective Color edits, in the order created

e Node edits, in the order created

Note: Because each edit applies to a specific rendering intent, the Edit List changes when you change rendering
intents.

Flattening a profile when you save it clears the Edit List. If you do not flatten a profile when you save it, the edit list is
stored in the profile. An unflattened profile is fully ICC compatible.

You can choose one or more edits in the list to perform tasks on them.

1 To see the Edit List of edits already made for the selected rendering intent, click the up or down arrow at the
bottom of the Edit Tools pane.

2 Use these tools to edit colors:

¢ Edit color globally - Adjusts the lightness, contrast, and saturation of the entire output and adjusts each
individual output curve (CMYK or RGB).

¢ Edit the colors in a hue - Shifts all colors of the same hue and a user-specified range of neighboring colors to a
different hue.
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 Edit a selected color - Changes one color and a user-specified range of neighboring colors in the source to a
different color in the output.

¢ Edit a node - Changes the color content of an individual node in the profile color table.

¢ Adjust white point (media color) - Changes the whitepoint value. Applies only to the Absolute Colorimetric
rendering intent.

Edit color globally

Each rendering intent in a profile can have only one global color edit, but the global color edit can modify multiple
properties.

1 Click Global Color.

2 Click one of the following tabs, depending on the type of edit that you want to make.
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¢ Lightness, Contrast, Saturation - Drag the sliders to adjust the lightness, contrast, and saturation of all colors.

¢ Output Curves - Drag the curves to adjust the input vs. output for each color channel.

Edit output curves
You can edit curves showing input vs. output for each color. You can edit only one curve at a time.

The eye icon under each color square in the channel selector (=" indicates whether the color curve is being
displayed. (One curve might be behind another.)

1 Click a curve’s color square to bring a curve to the front.

2 Click anywhere on the curve to create an edit point, and then drag the edit point to change the shape of a curve.

Other edit points on the same curve remain fixed.

Edit the colors in a hue

A hue edit is similar to a selective color edit, but it affects all colors of one hue rather than only a single color. Use a
hue edit to shift one hue in the source to a different hue in the output.

The hue edit applies to the source color currently set in the Color Information window.

Hues near the selected hue in the color space are affected by the hue edit. To preserve the smoothness of a color
gradient, you can increase this range of nearby hues. At the maximum range, a hue edit affects nearly all colors.

1 Click Hue Edit.
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2 Click one of the following Hue Selection tools and use it to specify the output hue:

¢ Hue and Saturation - Drag the Edited marker to set the hue and saturation values of the output hue.

¢ Profile Cross Section - Locate the output hue in a graphical representation of the output color space. The color
model (Lab or XYZ) that displays the color space is the same as the Profile Connection Space of the profile
being edited. The cross-section is a vertical plane of the Lab or XYZ color space where all the colors have the
same ratio of a/b or X/Y as the source color.

Set hue and saturation of the output

Hue and Saturation allows you to set the hue and saturation of the output hue.

A plus sign (F) to the left of each color bar indicates the source values. A white square () to the right of each color

bar indicates the output values of the original profile. A filled square (H) to the right of each color bar indicates the
output values of the edited profile.

The narrow areas of the Relative Saturation bar indicate that relatively fewer values are in-gamut. Where the bar is
thinnest, there are no in-gamut values.

Note: If the Saturation setting you want has no in-gamut values, try adjusting the Hue again.
1 Click Hue Edit.

2 C(Click Hue and Saturation and set Hue, Saturation, and Range for the output hue.

Select output hue using Profile Cross Section

Profile Cross Section locates the output hue in a graphical representation of the output color space.

The color model (Lab or XYZ) used to display the color space is the same as the Profile Connection Space of the
profile being edited. The cross-section is the horizontal plane (all colors have the same level of lightness) that
contains the source color in the Lab or XYZ color space.

The Edited color indicator (filled square) moves to the location that you set. A line drawn from the neutral (center)
axis to the Edited color indicator represents the new output hue. Profile Editor updates the colors close to the edited
hue (depending on the Range value).

1 Click Hue Edit.
2 Click Profile Cross Section.

Click the Eyedropper tool (_#).

H W

Click the new location for the output hue in the color space.
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Edit a selected color
Selective color edit lets you change one color in the source color space to a different color in the output. This is
useful if you need to reproduce an individual color exactly (a company logo color, for example).

The selective color edit affects colors near the selected color in the color space. To preserve color gradient
smoothness, you can increase this range of nearby colors. At the maximum range, a selective color edit becomes
similar to a hue edit.

The selective color edit applies to the source color currently selected in the Color Information window.
1 Click Selective Color.

2 Click one of the following Color Selection tools and use it to specify the output color:

e HLCEntry - Drag the Edited marker to set the hue, lightness, and chroma (similar to saturation) values of the
output color.

¢ Coordinate Entry - Type the color space coordinates of the output color or use the spectrophotometer to
sample the color of a physical object.

¢ Profile Cross Section - Locate the output color in a graphical representation of the output color space. The
color model (Lab or XYZ) that displays the color space is the same as the Profile Connection Space of the
profile being edited. The cross-section is a vertical plane of the Lab or XYZ color space where all the colors
have the same ratio of a/b or X/Y as the source color.

Set hue, lightness, and chroma of the output color

HLC Entry lets you set the hue, lightness, and chroma (similar to saturation) values of the output color.

A plus sign (+) to the left of each color bar indicates the source values. A white square (O) to the right of each color

bar indicates the output values of the original profile. A filled square (H) to the right of each color bar indicates the
output values of the edited profile.

The narrow areas of the Lightness and Chroma bars indicate that there are relatively fewer values that are in-gamut.
Where the bar is thinnest, there are no in-gamut values.

1 Set the Hue value of the replacement color by dragging the filled square (H) on the Hue bar to move it up or
down.

2 Set the Lightness value of the replacement color.
3 Set the Chroma value of the replacement color.

4 If there are no in-gamut values at the Lightness and Chroma setting you want, try adjusting the Lightness and
Chroma again.
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Set color space coordinates

Coordinate Entry lets you type the color space coordinates of the output color or use the spectrophotometer to
sample the color of a physical object.

Note: To set a different color model, click the color model icon ( *. for CMYK, for example) to the left of the
numerical fields, and set the color model from the list.

1 (Optional) Do one of the following to set the source color:

¢ Under Change Source Color, type the coordinates for the source color.

¢ Click the measurement instrument icon (%#) and sample the color of a physical object using the
spectrophotometer.

2 Do one of the following to set the output color:

¢ Under Target Output Color, type new coordinates for the output color.

¢ Click the measurement instrument icon (%#) and sample the color of a physical object using the
spectrophotometer.

Select output color using Profile Cross Section

Profile Cross Section locates the output color in a graphical representation of the output color space.

The color model (Lab or XYZ) that displays the color space is the same as the Profile Connection Space of the profile
being edited. The cross-section is a vertical plane of the Lab or XYZ color space where all the colors have the same
ratio of a/b or X/Y as the source color.

1 Click the Eyedropper tool (®#).

2 Click the new location for the output color in the color space.

The Edited color marker (filled square) moves to the location that you set. Profile Editor updates the colors close
to the edited color (depending on the Range value).

Edit a node

An output profile uses a set of data points called nodes. A node represents a sampled color at various locations
across the color space of a profile.

For colors that do not correspond exactly to a node color, Profile Editor infers colors by assuming that the transitions
from one node color to another are smooth and continuous. Thus a relatively small number of nodes can represent
the entire color space (a very large number of colors).

Profile Editor represents the Node Index as Axis 1, Axis 2, and Axis 3. These axes correspond to either L, a, and b or
X, Y, and Z depending on the model used by the Profile Connection Space (PCS) of the profile being edited.

Typing a value in the Neutral field locates that node on the neutral axis and adjusts the values of Axis 1, Axis 2, and
Axis 3 to match. You can increase or decrease the Neutral value to view the nodes associated with different gray
levels.
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For any given node index, the coordinates of the source and output colors associated with the node index are
displayed.

A node edit has the smallest effect of any type of edit and changes only one node in the profile. (The node edit alters
only the relationship of the color at one node to the colors around it and affects color transitions in the node’s
neighborhood.) By comparison, a selective color edit affects at least eight nodes.

One example of using a node edit is to adjust the neutral colors (a=b=0) of a profile. These adjustments are usually
very small.

Note: If you are editing a node that is near the edge of the gamut, we recommend that you specify the replacement
node color in CMYK color space rather than Lab. In this situation, the CMYK color space allows you more precise
control in specifying a color than the Lab color space.

Highlight affected colors

If you want better visibility of the selected node, you can apply a contrasting color.

» Select the Highlight check box to display the colors in the reference image and in the color space affected by this
edit in a contrasting color. Use this option to see which colors are affected by this edit.

Set node and color coordinates

Node and Color Coordinates allows you to type the node’s index and color space coordinates of its output color or
use the spectrophotometer to sample the color of a physical object.

1 Set a node using one of two methods:

¢ Set a source color, or click the source measurement instrument icon (*#) under Nearby (Source) Color and
sample the source color using the spectrophotometer, and then click Find Nearest Node.

If the currently selected color does not correspond exactly to a node, the color of the node nearest to the
selected color is selected.

¢ Under Node Index, type the coordinates of the node index.

2 Do one of the following:

¢ Under Replacement Node Color, type the output color’s coordinates.

¢ Click the output measurement instrument icon (%§) and sample the output color using the spectrophotometer.

Select output node using Profile Cross Section

You can set a source color and locate the corresponding output color in a graphical representation of the output
color space.

Profile Cross Section can display the output color that corresponds to a source color. The display, using a graphical
representation of the output color space, uses the same color model (Lab or XYZ) as the Profile Connection Space of
the profile.
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XYZ color space is a horizontal plane where all colors have the same level of lightness.

o Leaf displays a two-dimensional plane of the Lab or XYZ color space. This is a vertical leaf where the ratio of a/b
or X/Y of all colors is the same.

¢ Plane displays a two-dimensional plane of the Lab color space.

The color model (Lab or XYZ) used to display the color space is the same as the Profile Connection Space of the
profile being edited.

1 Click Plane or Leaf.

2 Set a node using one of these methods:

¢ Set a source color, or click the source measurement instrument icon (%#) under Nearby (Source) Color and
sample the source color using the spectrophotometer, and then click Find Nearest Node.

If the currently selected color does not correspond exactly to a node, the color of the node nearest to the
selected color is selected.

e Click the source Eyedropper tool (*#), and click the node you want to edit in the profile cross-section.

¢ Type the coordinates of the node index directly. You can also use the up arrow or down arrow to increase or
decrease a value.

3 Under Replacement Node Color, set the output color using one of two methods:

¢ Type the coordinates of the output color, or click the output measurement instrument icon (%§) and sample
the output color using the spectrophotometer.

¢ Click the output Eyedropper tool (®#), and click the output color in the profile cross-section.

Adjust white point (media color)

The Media Whitepoint Edit tool can adjust the profile for the color of the paper stock. Setting the Media Whitepoint
tool automatically selects the Absolute Colorimetric rendering intent, which is the only rendering intent that
specifies media color.

You can set the Lab or XYZ color model to edit the whitepoint.

The color swatches show the colors of the original and edited media whitepoints.
» Do one of the following:

¢ Type values in the Edited fields.

¢ Click the measurement instrument icon (*%#) and use the spectrophotometer to sample the color of the media
(paper).
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Sample a color with a measuring instrument

With a spectrophotometer connected to your computer, you can sample a color in any place where you see the

measuring instrument icon with a “green light” (%) to indicate that the icon is active.
Note: Before using the spectrophotometer, you must initialize and calibrate it.

1 Click the icon to activate the green light if it is not already displayed.

2 To calibrate the measurement instrument, click Instrument > Calibrate.

3 Select your desired measured mode from the list and then click Calibrate.

82
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Fiery Verify

Fiery Verify in Fiery Color Profiler Suite helps you check printed color against a standard reference. You print and
measure a color bar and compare the measured results to a reference using a selected set of tolerances. If a measured
value matches its expected value within the tolerance, the printed color meets the standard for the specific color. If
all colors pass, the printed output fully conforms to the reference.

Fiery Verify provides a number of reference presets, which are predefined combinations of a reference (such as PSD
Coated) and a color bar (set of color patches to be measured). You can define new reference presets as well.

Verify color against a reference

To verify color, you print and measure color test patches for a specific reference. If the color patch page is already
printed, you can skip printing.

1 In Fiery Color Profiler Suite, click Verify.

2 Select a Fiery server from the list.

If the Fiery server is not in the list, click the plus sign to add it using the IP address or by searching.

3 Select a Job properties preset.

If you just created a profile from Fiery Express Profiler, Fiery Printer Profiler or Fiery Print Matcher, pick a preset
to verify the precision of your profile.

If a preset is not available that uses the color settings that you wish to verify, click Edit and specify custom job
properties, such as source profile, output profile, etc.

4 Select a Verification preset and click Next.

Verification presets specify the reference color space and the tolerances for the verification test. Pick the preset
for your preferred CMYK reference (such as Fogra, GRACoL or CRPC) and the tolerance setting.

If you want to create your own Verification preset, click Edit.
5 Select the measurement instrument and specify warmup pages if desired, and click Print.
Warmup pages are beneficial if the printer has not been used for a period of time.

Click Settings to the right of the instrument selection to configure spectrophotometer settings such as
Measurement mode.

6 Retrieve the pages from the printer and follow the on-screen instructions to measure the page. (Discard any
warmup pages.)
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7 When you are done measuring, click Next to view the results.
Fiery Verify displays the results including passed or not passed status, and a summary of the verification settings.

Click View Detail to view a detailed report. Fiery Verify displays the reference values compared with the
measured values and indicates pass or fail for each value. To record the results, you can print a report or a label.

Click Print Report to create a detailed report in PDF format.
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Fiery Verify Assistant

Fiery Verify Assistant helps to evaluate the color accuracy achieved when printing a particular job from Command
WorkStation.

Use Fiery Verify Assistant

You can start Fiery Verify Assistant from Command WorkStation when Fiery Color Profiler Suite version 5.1 or later
is installed on the same system as Command WorkStation 6.3 or later. You do not access Fiery Verify Assistant from
the main window of Fiery Color Profiler Suite.

1
2

In Command WorkStation, connect to the Fiery server for which you want to test the color precision of a job.

Select a printed or held job that has the print settings that you want to evaluate, and do one of the following:

¢ Click Actions > Color Verification.

¢ Right-click on a job and select Color Verification from the menu.

Make sure to select only one job. Fiery Verify Assistant cannot be started if multiple jobs are selected.

Fiery Verify Assistant starts in a separate window.

Note: The Command WorkStation window is not updated while Fiery Verify Assistant is running. You must exit
Fiery Verify Assistant to continue using Command WorkStation.

Select a Verification preset and click Next.

Verification presets specify the reference color space and the tolerances for the verification test. Pick the preset
for your preferred CMYK reference (such as Fogra, GRACoL or CRPC) and the tolerance setting.

If you want to create your own Verification preset, click Edit.
Select the measurement instrument and specify warmup pages if desired, and click Print.
Warmup pages are beneficial if the printer has not been used for a period of time.

Click Settings to the right of the instrument selection to configure spectrophotometer settings such as
Measurement mode.

Retrieve the pages from the printer and follow the on-screen instructions to measure the page. (Discard any
warmup pages.)
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6 When you are done measuring, click Next to view the results.
Fiery Verify displays the results including passed or not passed status, and a summary of the verification settings.

Click View Detail to view a detailed report. Fiery Verify displays the reference values compared with the
measured values and indicates pass or fail for each value. To record the results, you can print a report or a label.

Click Print Report to create a detailed report in PDF format.

Click Print Label to print a certification label that can be applied to a print or proof.
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Select a profile

When you are performing a task that requires one or more profiles, you can select standard ICC profiles as well as
profiles in locked (.xcc) format in Fiery Color Profiler Suite, as long as you originally created the locked profiles on
this computer. You cannot open locked profiles created on other computers.

1 In the Select Profile window, select a location in the From list.
The Select Profile window displays the profiles that are in the selected location.

The list groups profiles by class or by color space. Clicking a setting in the Show list limits the list of profiles that
appear to a specific profile class or color space.

2 Do one of the following:

¢ Click a profile name in the Profiles area, and click Select.

¢ Click a profile name in the Recently used profiles area, and click Select.

Add and remove locations in the From list

The From list displays predefined locations.
The display depends on the operating system.
e For Windows, the location name is System. The path for System is WINDOWS\system32\spool\drivers\color.

e For macOS, there are two location names: System and User. The path for System is WINDOW S\system32\spool
\drivers\color. The path for User is ~/System/Library/ColorSync/Profiles.

You can also add or remove a local folder, Fiery server, or Fiery XF server to the From list.

« Do one of the following:
¢ To add a local folder to the From list, click Open, browse to the folder, click a profile, and then click Open.
¢ To add a Fiery server to the From list, click Add Fiery and click the Fiery server.

¢ To add a Fiery XF server to the From list, click Add Fiery XF and click the Fiery XF server. If you find no
servers, locate and select the Fiery XF server manually.

¢ To remove a location from the From list, click the location, and then click the minus sign (-).



Fiery Color Profiler Suite Help 88
Select a profile

Unlock a profile in Color Profiler Suite

If Color Profiler Suite is running in licensed mode (not in Demo mode), you can convert a locked (.xcc) profile to the
standard ICC format.

This converts the profile to the standard ICC format (the version, 2.0 or 4.0, is not changed) and the new profile
replaces the locked profile.

1 In the Select Profile window, click the profile name.
2 Click Unlock Profile.

3 If Unlock Profile does not become active when you select the profile name, confirm that the following conditions
are true:

¢ Under Profile Information, the profile name has the .xcc extension, indicating that it is in the locked format.
¢ Fiery Color Profiler Suite is running in licensed mode (not in Demo mode).

¢ The profile was created on this computer.
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Rendering intents

An output profile maps out-of-gamut colors to colors in the gamut of the output device. The output profile may also
map in-gamut colors to different colors to preserve the relationships between all colors.

There are many ways to map colors, each of which can have different significant effects on output.

The ICC specification defines several ways of mapping colors, called a rendering intent. When you print using a
profile, some applications allow you to select the rendering intent that is most appropriate for the images you are
printing.

A profile contains data for the following rendering intents:

Perceptual - Preserves tonal relationships in images for perceptually pleasing color. Often used for photographs,
including scans and images from stock photography and digital camera images. Typically results in less saturated
output than Saturation rendering when printing out-of-gamut colors.

Fiery uses the name Photographic for its implementation of the Perceptual rendering intent. Perceptual
(Photographic) selects the Photographic rendering intent for an Fiery-supplied profile or the Perceptual
rendering intent for other profiles.

Saturation - Creates saturated colors but does not match printed colors precisely to displayed colors. Often used
for charts and graphs in presentations. Works well for in-gamut colors in images as well as out-of-gamut colors
in presentation graphics.

Fiery uses the name Presentation for its implementation of the Saturation rendering intent. Saturation
(Presentation) selects the Presentation rendering intent for an Fiery-supplied profile or the Saturation rendering
intent for other profiles.

Relative Colorimetric - Attempts to provide an exact color match between source and destination. This
rendering intent maps out-of-gamut colors to the nearest in-gamut color. It provides white-point transformation
between the source and destination whitepoints. For example, the bluish white color (gray) of a monitor is
replaced by paper white. Often used when color matching is important (for example, logo color), even at the
expense of tonal relationships.

Use Relative Colorimetric rather than Absolute Colorimetric intent if you prefer white colors in an image to
print as paper white.

Absolute Colorimetric - Is similar to Relative Colorimetric but provides no whitepoint transformation between
the source and destination whitepoints. Whites in an image are reproduced as printed color (simulating the
destination paper color) rather than replaced by paper white. Best used when you need exact colors, such as for
proofing.
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Add a Fiery server

You can add a Fiery server from the network. You can also add a Fiery server from the Favorite list.

You will need the DNS name or IP address of the Fiery server. If you do not have the DNS name or IP address, you
can use Search.

« Do one of the following:

¢ In the Add Fiery Server window, type the IP address or DNS name for the Fiery server in the Add a server
field. and then click OK.

¢ In the Add Fiery Server window, click the Fiery server in the Favorite list, and then click OK.
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Add a Fiery XF server

You can add a Fiery XF server from the network.

You will need the DNS name or IP address of the Fiery XF server. If you do not have the DNS name or IP address,
you can use Search to find available Fiery XF server.

Note: Fiery XF is supported with Fiery Printer Profiler, Fiery Monitor Profiler, Fiery Profile Inspector, and Fiery
Profile Editor. When Fiery Color Profiler Suite is opened from Fiery Command WorkStation, you can also use Fiery
Optimizer with a Fiery XF server.

 In the Fiery XF Discovery window, click Manual, type the IP address for the Fiery XF server in the IP Address
field, and then click OK.
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